Caliper Life Sciences, Inc. Product Warranty

I. INSTRUMENTS
Caliper® Life Sciences, Inc. ("Caliper") warrants your Caliper-manufactured instrument’s hardware and firmware against defects in material and workmanship for a period of one (1) year from the date of shipment, subject to the exclusions set forth below and: (i) the warranty for TurboVap products shall be ninety (90) days from the date of shipment, (ii) the warranty for Limited-Life Parts (as defined below) shall be thirty (30) days from the date of installation, and (iii) the warranty for cosmetic surfaces shall be thirty (30) days from the date of installation (each, a "Warranty Period"). Ongoing service support after the Warranty Period may be available at an additional expense.

A. What is Included during the Warranty Period:
• unlimited emergency on-site repair services, parts and software updates that affect original functional design specifications, their associated labor and travel expenses.
• unlimited access to Caliper’s Technical Support Center, which provides troubleshooting, repair instruction, service dispatching (other than for TurboVap and Twister I), replacement part information and shipment.
• one pre-scheduled, on-site Preventive Maintenance and Diagnostic Servicing (PM) performed by a Caliper Field Service Engineer. A PM visit includes the replacement of a pre-defined list of Limited-Life Parts exposed to fluidics, such as syringes, valves, seals and fittings. The Caliper Field Service Engineer will perform comprehensive analysis and testing to confirm that the equipment is left operating to factory specifications. Scheduling of the PM within the Warranty Period is flexible and determined by the customer after notification by the Caliper Field Service Engineer. The servicing is typically scheduled six months after the equipment installation, but equipment usage rate and availability may cause the date to vary.
• A completed Caliper Field Service Report provides thorough documentation of all maintenance and service work performed by the Caliper Field Service Engineer during an on-site visit. Documentation is not provided when Caliper provides service via telephone, fax or email.

Any failure of a product to conform to this Warranty shall be corrected by replacing or repairing the affected product or refunding the purchase price (as described below), in each case at Caliper’s option. Parts replaced during the Warranty Period will be covered for the remaining term of the original Warranty Period, or for thirty (30) days from time of replacement, whichever is longer. Such replacement parts may, at Caliper’s option, be new or remanufactured. All parts removed from warranted equipment become the property of Caliper. Caliper reserves the right to satisfy its warranty obligations in full by refunding the purchase price of any non-conforming product, minus any service, validation, or travel charges.

B. Customer Responsibilities
In order for a product to be covered under this Warranty, Customer must comply with the following terms:
• The equipment must be used under normal installation and application conditions as described in the product’s User Manual.
• The equipment must be maintained as described in the User Manual.
• Only water or DMSO at a maximum concentration of 65% may be used as a system fluid in the Sciclone inL10. Any other system fluid must be approved by Caliper before use in the inL10.
• Customer is responsible for making the equipment available for a PM visit during the Warranty Period. Caliper will not be held liable for a missed PM visit due to restricted access to the equipment during the Warranty Period.
• When Caliper provides telephone, fax, or email support, Customer is responsible for completing any necessary documentation of the service.
• If Customer maintains a change control/validation logbook as a permanent record, then Customer is responsible for entering all service documentation into such logbook.
• Customer must perform the appropriate level of revalidation required as a result of the maintenance or service provided.

C. Exclusions
• Failure to comply with any of the Customer Responsibilities listed above will void this Warranty.
• Any alteration of hardware or software on products covered under this Warranty that are not performed by Caliper or an approved Caliper vendor will void this Warranty.
• A product that has been subject to misuse, accident, negligence or improper transportation, handling, installation, storage, use, or maintenance is not covered under this Warranty.
• Many Caliper products require the use of Caliper Automation Certified Disposables for proper operation. These may include, but are not limited to: pipet tips, seals, labels and filters. Use of a Caliper product with any disposables other than the specified Caliper Automation Certified Disposables will void this Warranty.
• This Warranty covers equipment manufactured by Caliper. Equipment purchased from other vendors is not covered by this Warranty.
• Damage to Limited-Life Parts caused by insufficient maintenance or cleaning practices or unauthorized applications are not covered under this Warranty.
• This Warranty applies only to the original buyer and delivery location. It is not transferable to other buyers or locations without Caliper’s prior written approval.

1. TurboVap and Twister I are not eligible for on-site service or a PM visit, and must be returned to Caliper’s Repair Depot for warranty service pursuant to the process set forth in Section E below.
• The Sciclone 384-channel low-volume head is warranted for one (1) year or 750,000 aspirate or dispense movements, whichever comes first.
• The Sciclone 100nL head is warranted for one (1) year or 600,000 aspirate or dispense movements, whichever comes first.
• The laser component of the LabChip 3000 is warranted for the earlier of one (1) year from the date of installation or 8,000 hours of use.
• The use in a Sciclone in10 of DMSO above 65% concentration, or any other system fluid not sanctioned for use by Caliper, will invalidate this warranty as it relates to the pipetting head assembly.

If Caliper performs service on equipment and determines that any of the exclusions set forth in this Warranty apply, then Caliper shall charge Customer its then-current current list prices for parts, labor and travel.

D. Limited-Life Parts
Limited-Life Parts are any parts that are exposed to solvents, reagents, or samples. Such parts include, but are not limited to syringes, valves, seals and fittings. A pre-defined list of Limited-Life Parts are routinely replaced by Caliper Field Service Engineers during a PM visit or during Caliper Repair Depot servicing. Otherwise, these parts are available from Caliper at current list prices and are designed for replacement by Customer.

E. Equipment Return Policy
In servicing situations requiring the return of equipment to Caliper, equipment must be returned to Hopkinton, MA, USA, or another facility designated by Caliper. Customer shall prepay shipping charges for equipment returned to Caliper, and Caliper will pay for return shipment to Customer.

A Returned Material Authorization (RMA) must be obtained for any equipment being returned to Caliper. Contact the Caliper Technical Support Center by telephone at (508)-435-9761, or via the Internet at techsupport@caliperls.com or by fax at (508)-435-0950 before returning any equipment to Caliper. Customer must complete a Caliper Chemical Questionnaire prior to the issuance of an RMA. All equipment returned to Caliper must first be decontaminated to meet Caliper and United States Department of Transportation procedures and standards for the safety of Caliper personnel.

F. Hazardous Limitation Statement
At no time will Caliper personnel perform service on unsafe equipment, perform service in unsafe environments or decontaminate equipment to make it safe.

Prior to performing any service work, Caliper personnel will evaluate the condition of the equipment and the environment in which the equipment is located. If Caliper determines that the equipment and/or the environment could be hazardous to Caliper personnel, Caliper reserves the right to refuse to service the equipment.

II. MICROFLUIDIC CHIPS
Caliper warrants that microfluidic chips (each, a “Chip”) purchased from Caliper by Customer will be free from defects in material and workmanship for a period of sixty (60) days from the date of shipment (the “Warranty Period”). A “defect” for purposes of this Warranty is defined as any failure that occurs during analysis of the first one hundred (100) samples being run on a Chip. During the Warranty Period, if the Chip fails to comply with this Warranty, Caliper will repair or replace the Chip at its option and expense. If a Chip becomes damaged or its performance otherwise deteriorates due to solvents and or reagents other than those supplied or expressly recommended by Caliper, Caliper will replace the Chip at Customer’s request and expense. No such replacement will extend the original Warranty Period. This Warranty does not extend to any Chip which has been (a) the subject of an accident, misuse, or neglect, (b) modified by a party other than Caliper, (c) used in a manner not in accordance with the instructions contained in the product User’s Manual, or (d) used for an assay or application which has not been approved by Caliper. All claims under this Warranty must be made within thirty (30) days of the discovery of the defect. Caliper’s obligations under this Warranty are limited to replacement as Caliper deems necessary to correct those failures of the Chip to comply with this Warranty of which Caliper is notified prior to expiration of the Warranty Period.

III. GENERAL
CALIPER SPECIFICALLY DISCLAIMS ANY AND ALL OTHER PROMISES, REPRESENTATIONS, AND WARRANTIES, EXPRESSED OR IMPLIED. THIS INCLUDES, BUT IS NOT LIMITED TO, THE PRODUCT’S CONDITION, ITS CONFORMITY TO ANY DESCRIPTION OR REPRESENTATION, THE EXISTENCE OF ANY LATENT OR PATENT DEFECTS, AND IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. IN NO EVENT WILL CALIPER BE LIABLE, WHETHER ARISING IN CONTRACT, TORT (INCLUDING NEGLIGENCE), STRICT LIABILITY OR OTHERWISE, FOR ANY LOSS OF PROFIT OR ANY OTHER COMMERCIAL DAMAGES, INCLUDING, BUT NOT LIMITED TO, SPECIAL, INCIDENTAL, CONSEQUENTIAL, OR OTHER AND IN NO EVENT SHALL CALIPER’S LIABILITY EXCEED THE PURCHASE PRICE OF THE PRODUCT. THERE ARE NO ORAL STATEMENTS, PROMISES, REPRESENTATIONS OR OTHER WARRANTIES COLLATERAL TO OR AFFECTING THIS WARRANTY. THIS WARRANTY EXTENDS TO BUYER ONLY AND NOT TO PURCHASERS OR USERS OF BUYER’S PRODUCTS.

No agent, employee, or representative of Caliper has any authority to bind Caliper to any affirmation, representation, or warranty concerning a Caliper product that is not contained in Caliper’s printed product literature or this Warranty. Any such affirmation, representation, or warranty made by any agent, employee, or representative of Caliper will not be binding on Caliper.
Caliper Life Sciences, Inc. Software License Agreement

Thank you for purchasing our products. PLEASE READ THE TERMS AND CONDITIONS OF THIS LICENSE AGREEMENT CAREFULLY BEFORE OPENING THE PACKAGE CONTAINING THE SOFTWARE MEDIA, THE COMPUTER SOFTWARE CONTAINED THEREIN, AND THE ACCOMPANYING USER DOCUMENTATION (COLLECTIVELY REFERRED TO HEREIN AS THE "PROGRAM"). THE PROGRAM IS COPYRIGHTED AND LICENSED, NOT SOLD. BY OPENING THE PACKAGE CONTAINING THE PROGRAM, YOU ARE ACCEPTING AND AGREEING TO THE TERMS OF THIS LICENSE AGREEMENT. IF YOU ARE NOT WILLING TO BE BOUND BY THE TERMS OF THIS LICENSE AGREEMENT, YOU SHOULD PROMPTLY RETURN THE PROGRAM IN UNOPENED FORM, AND YOU WILL RECEIVE A REFUND. THIS LICENSE AGREEMENT REPRESENTS THE ENTIRE AGREEMENT CONCERNING THE PROGRAM BETWEEN YOU AND CALIPER® LIFE SCIENCES, INC. (REFERRED TO AS "LICENSOR"), AND IT SUPERSEDES ANY PRIOR PROPOSAL, REPRESENTATION, OR UNDERSTANDING BETWEEN YOU AND LICENSOR.

1 License Grant. 
Licensor hereby grants to you, and you accept, a nonexclusive license to use the Program only as authorized in this License Agreement. The software included in the Program (the "Software") may be used only on a single computer owned, leased, or otherwise controlled by you; or, in the event of the inoperability of that computer, on a backup computer selected by you. If the Software is an applications package, you may use it on a single, local system controller. Neither concurrent use on two or more computers nor use in a local area network or other network is permitted without written authorization from licensor and the payment of additional license fees. You agree that you will not assign, sublicense, transfer, pledge, lease, rent, or share your rights under this License Agreement, except that you may permanently transfer all of your rights under this License Agreement, provided that you retain no copies, you transfer all of the Program, and the transferee agrees to the terms of this License Agreement. You agree that you may not reverse assemble, reverse compile, or otherwise translate the Software.

Upon loading the Software into your computer, you may retain the Software media for backup purposes. In addition, you may make one copy of the Software on a second medium for the purpose of backup in the event the Software media is damaged or destroyed. Any such copies of the Software shall include Licensor's copyright and other proprietary notices. Except as authorized under this paragraph, no copies of the Program or any portions thereof may be made by you or any person under your authority or control.

2 Licensor's Rights. 
Licensor has invested significant time and money in developing the products purchased with the Program. The Program contains Licensor's trade secrets, which must be used in confidence. You acknowledge and agree that the program is proprietary to Licensor and protected under U.S. copyright law. You further acknowledge and agree that all right, title, and interest in and to the Program, including associated intellectual property rights, are and shall remain with Licensor. This License Agreement does not convey to you an interest in or to the Program, but only a limited right to use it, revocable in accordance with the terms of this License Agreement. In the event of a breach, the Licensor reserves the right to seek equitable relief.

3 License Fees. 
The license fees paid by you in connection with the purchase of the associated product(s) are paid in consideration of the licenses granted under this License Agreement.

4 Term. 
This License Agreement is effective upon your opening of this package and shall continue until terminated. You may terminate this License Agreement at any time by returning the Program, and all copies thereof and extracts therefrom to Licensor. Licensor may terminate this License Agreement upon the breach by you of any term hereof. Upon such termination byLicensor, you agree to return to Licensor the Program and all copies and portions thereof.

5 Limited Warranty. 
Licensor warrants, for your benefit alone, for a period of 90 days from the date of the commencement of this License Agreement (referred to as the "Warranty Period") that the Software Media in which the Software is contained are free from defects in material and workmanship. If, during the Warranty Period, a defect in the Software Media arises, you may return the Program to Licensor for either replacement or, if so elected by Licensor, refund of amounts paid by you under this License Agreement. You agree that the foregoing constitutes your sole and exclusive remedy for breach by Licensor of any warranties made under this License Agreement. EXCEPT FOR THE WARRANTIES SET FORTH ABOVE, THE PROGRAM IS LICENSED "AS IS," AND THE LICENSOR DISCLAIMS ANY AND ALL OTHER WARRANTIES, WHETHER EXPRESS OR IMPLIED, INCLUDING, WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

6 Limitation of Liability. 
Licensor's cumulative liability to you or any other party for any loss or damages resulting from any claims, demands, or actions arising out of or relating to this License Agreement shall not exceed the license fee paid to Licensor for the use of the Program. In no event shall Licensor be liable for any indirect, incidental, consequential, special, or exemplary damages or lost profits, even if Licensor has been advised of the possibility of such damages. SOME STATES DO NOT ALLOW THE LIMITATION OR EXCLUSION OF LIABILITY FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATION OR EXCLUSION MAY NOT APPLY TO YOU.
7 Software Updates.
Licensor periodically creates Software updates which will be made available to you at no charge. Thereafter, Licensor shall not be responsible for your use of, and shall not warrant or repair, superseded or outdated versions of Software.

8 Governing Law.
This License Agreement shall be construed and governed in accordance with the laws of the Commonwealth of Massachusetts. Any dispute will be resolved in the state and federal courts of the Commonwealth of Massachusetts.

9 Severability.
Should any term of this License Agreement be declared void or unenforceable by any court of competent jurisdiction, such declaration shall have no effect on the remaining terms hereof.

10 No Waiver.
The failure of either party to enforce any rights granted hereunder or to take action against the other party in the event of any breach hereunder shall not be deemed a waiver by that party as to subsequent enforcement of rights or subsequent actions in the event of future breaches.
Preface

Copyright

This manual is published by Caliper Life Sciences, Inc., 68 Elm Street, Hopkinton, MA 01748 USA. Copyright 2001 - 2006, Caliper Life Sciences, Inc. All rights reserved. Reproduction by any means or in any form of this manual or the products it describes is prohibited.

Trademarks

Caliper, CLARA, and Twister are registered trademarks of Caliper Life Sciences, Inc. The Caliper logo, iLink, and XP Robot are trademarks of Caliper Life Sciences, Inc. Microsoft, Windows, and Windows NT are either registered trademarks or trademarks of Microsoft Corporation in the United States and/or other countries. All other trademarks and registered trademarks are the property of their respective holders.

Contents

The information in this manual may contain typographical errors or technical inaccuracies and is subject to change without notice. Modifications may also be made to the product described in this manual at any time.

Statement of Proper Use

The Twister® II robot and XP Robot™ are designed to be used in a laboratory environment to move microplates and deepwell plates. The Robots and Robot software are designed to be used in integrated systems controlled by the Caliper automation control software. Easy-to-use Teach Wizards simplify the process of teaching robot positions, and the convenient Twister II storage racks hold the plates during processing.

WARNINGS

- To reduce the risk of electric shock, do not remove the cover. No user serviceable parts are inside the Twister II. Refer to qualified service personnel if help is required.
- Use this product only in the manner described in this manual. If the equipment is used in a manner not specified by the manufacturer, the protection provided by the equipment may be impaired.
AVERTISSEMENTS

• Pour réduire le risque de choc électrique, ne pas retirer le
couvercle. Le Twister II ne contient aucune pièce pouvant être
réparée par l’utilisateur. Au besoin, confier l’appareil à un
réparateur qualifié.

• Ce produit ne doit être utilisé que comme décrit dans ce
manuel. Si cet appareil est utilisé d’une manière autre que celle
spécifiée par le fabricant, la protection fournie par l’appareil peut
être entravée.

Contact Us

If you have a question about a product that is not answered in this
manual, or if you need assistance regarding this product, please
contact the Caliper Technical Support Center from 8:00 A.M. to 8:00
P.M., Eastern Time, Monday through Friday:
Phone:  (508) 435-9761
Fax:  (508) 435-0950
Email:  techsupport@caliperLS.com
Internet:  www.caliperLS.com

For support in Europe contact Caliper Life Sciences LTD, Runcorn,
UK +44-1928-711448 or fax +44-1928-791228. For more
information contact your local Caliper representative.

Before you call, you should have the following information available
for the technical representative:
• Product serial number
• Software version (found by choosing About from the main Help
  menu)
• If applicable, the error number shown in the software.
Product Service and Customer Support Plans

Caliper offers a full range of services to ensure your success. From our original factory warranty through a comprehensive line of customer support plans, Caliper offers you Field Service Engineers and in-house Specialists who are dedicated to supporting your hardware, software and application development needs.

Call:  (508) 435-9761
Fax:  (508) 435-0950
Email:  techsupport@caliperLS.com

Our programs can include such useful services as:

• Preventive maintenance
• Diagnostic servicing performed on-site by Caliper field service engineers
• Extended use of the Caliper Technical Support Center
• Use of a software program for automated, remote troubleshooting
• Software updates
• Parts, labor, and travel expense coverage
• Other customized services upon request

Training For Your Product

Contact the Caliper Center for Training and Development for information about the availability of training courses for your product:

Call:  (508) 497-2634
Fax:  (508) 435-3439

FCC

This device complies with part 15 of the FCC (United States Federal Communications Commission) Rules. Operation is subject to the following two conditions:

• This device may not cause harmful interference, and
• This device must accept any interference received, including interference that may cause undesired operation.
CE

This device complies with all CE rules and requirements.

NOTE

Changes or modifications to this equipment not expressly approved by the party responsible for compliance could void the user’s authority to operate the equipment.

REMARQUE

Tout changement ou modification apporté à cet instrument non expressément approuvé par l'entité responsable de la conformité peut annuler l’autorisation d’opérer l’appareil accordée à l’utilisateur.
Table of Symbols

*Table 1* contains symbols that identify particularly important information and alert you to the presence of hazards. Some of these symbols may not appear in this manual or on the product it describes:

**Table 1. Important Symbols**

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="DANGER" /></td>
<td><strong>DANGER</strong>: An imminently hazardous situation, which, if not avoided, will result in death or serious injury. <strong>DANGER</strong> : Situation présentant un danger imminent qui, s’il n’est pas éliminé, peut entraîner des blessures graves, voire la mort.</td>
</tr>
<tr>
<td><img src="image2.png" alt="WARNING" /></td>
<td><strong>WARNING</strong>: Caution, risk of danger. Refer to the User’s documentation. <strong>AVERTISSEMENT</strong> : Attention, danger potentiel. Se reporter à la documentation de l’utilisateur.</td>
</tr>
<tr>
<td><img src="image3.png" alt="NOTE" /></td>
<td><strong>NOTE</strong>: A cautionary statement; an operating tip or maintenance suggestion; may result in instrument damage if not followed. <strong>REMARQUE</strong> : Énoncé indiquant une précaution à prendre, un conseil de fonctionnement ou une suggestion d’entretien; son non-respect peut provoquer des dommages à l’instrument.</td>
</tr>
<tr>
<td><img src="image4.png" alt="Hazardous voltage" /></td>
<td>Hazardous voltage; risk of shock injury. Tension dangereuse; risque de blessure par électrocution.</td>
</tr>
<tr>
<td><img src="image5.png" alt="Crush hazard" /></td>
<td>Crush hazard. Risk of body parts, hair, jewelry, or clothing getting caught in a moving part. Danger d’écrasement. Faire attention que les parties corporelles, les cheveux, les bijoux ou les vêtements ne soient pas pris dans une pièce mobile.</td>
</tr>
<tr>
<td><img src="image6.png" alt="Risk of puncture injury" /></td>
<td>Risk of puncture injury. Risque de blessure par piqûre.</td>
</tr>
<tr>
<td><img src="image7.png" alt="Risk of eye injury" /></td>
<td>Risk of eye injury; wear safety glasses. Risque de lésion oculaire; porter des lunettes de sécurité.</td>
</tr>
<tr>
<td>Symbol</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>![⚠️]</td>
<td>Hazardous fumes. Émanations dangereuses.</td>
</tr>
<tr>
<td>![⚠️]</td>
<td>Hot surface; risk of burns. Surface chaude; risque de brûlures.</td>
</tr>
<tr>
<td>![_ground]</td>
<td>Protective ground symbol. Symbole de terre de protection.</td>
</tr>
<tr>
<td>![ground]</td>
<td>Ground symbol. Symbole de terre.</td>
</tr>
<tr>
<td>![fuse]</td>
<td>Fuse. Fusible.</td>
</tr>
<tr>
<td>![on]</td>
<td>On (supply). Marche (alimentation).</td>
</tr>
<tr>
<td>![off]</td>
<td>Off (supply). Arrêt (alimentation).</td>
</tr>
<tr>
<td>![ce]</td>
<td>CE compliance mark. Marque de conformité CE.</td>
</tr>
</tbody>
</table>
### Table 1. Important Symbols (Continued)

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="H-POT" /></td>
<td>Signifies that the unit has passed safety tests for grounding, power line transience, and current leakage.</td>
</tr>
<tr>
<td><img src="image" alt="Input" /></td>
<td>Input.</td>
</tr>
<tr>
<td><img src="image" alt="Output" /></td>
<td>Output.</td>
</tr>
<tr>
<td><img src="image" alt="Equipment labels" /></td>
<td>Equipment labels are color coded:</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Yellow" /></td>
<td>Caution, risk of danger</td>
</tr>
<tr>
<td><img src="image" alt="Red" /></td>
<td>Stop</td>
</tr>
<tr>
<td><img src="image" alt="Blue" /></td>
<td>Mandatory action</td>
</tr>
<tr>
<td><img src="image" alt="Green" /></td>
<td>Safe condition or information</td>
</tr>
<tr>
<td><img src="image" alt="Jaune" /></td>
<td>Attention, danger potentiel</td>
</tr>
<tr>
<td><img src="image" alt="Rouge" /></td>
<td>Arrêter</td>
</tr>
<tr>
<td><img src="image" alt="Bleu" /></td>
<td>Intervention obligatoire</td>
</tr>
<tr>
<td><img src="image" alt="Vert" /></td>
<td>Condition sûre ou informations de sécurité</td>
</tr>
<tr>
<td><img src="image" alt="Helpful hints" /></td>
<td>Helpful hints, additional information</td>
</tr>
<tr>
<td><img src="image" alt="Conseils utiles" /></td>
<td>Conseils utiles, informations supplémentaires</td>
</tr>
</tbody>
</table>
Table of Contents

Caliper Life Sciences, Inc. Product Warranty .............................................................. 2
Caliper Life Sciences, Inc. Software License Agreement .......................................... 4
Preface ....................................................................................................................... 6
Introduction............................................................................................................... 16
Robot Software Terminology ................................................................................... 17
  Positions ............................................................................................................... 17
  Paths ..................................................................................................................... 19
  Position Types .................................................................................................... 19
  Robot Procedures .............................................................................................. 19
  Robot Files ........................................................................................................ 20
    Robot.ini File .................................................................................................... 20
  Storage Configuration using Stack Storage Software ............................................. 21
  Material Layout using iLink PRO Storage Software .............................................. 22
  Restacking .......................................................................................................... 22
  Lids ....................................................................................................................... 22
  Remote and Standalone Modes .......................................................................... 22
Operation ................................................................................................................... 23
  Robot Software Setup ......................................................................................... 23
    Start the Robot Software .................................................................................. 24
    Create a New Robot Project ............................................................................. 25
    Configure the Robot Software ...................................................................... 26
    Initialize and Home the Robot ....................................................................... 27
    Customize the User Interface ......................................................................... 28
  Stack Storage Setup .......................................................................................... 29
    Setting up a Storage Configuration ................................................................ 29
  iLink PRO Storage Setup .................................................................................... 35
    Adding Materials to the Twister II Racks in iLink PRO ..................................... 35
    Example: Adding Multiple Materials to Twister II Racks ................................. 35
  Running the Robot with Caliper Automation Control Software ............................ 38
    Starting the Robot Software in Remote Mode ................................................. 42
    Loading the Materials into the Twister II Racks ............................................ 42
    Viewing the Material Positions while a CLARA Application is Running ........... 44
  Error Recovery .................................................................................................. 45
    Using the Robot Software and the Stack Storage Software during Error Recovery ......................................................... 45
    Errors During a Move Instruction .................................................................. 45
    Retry Operation ................................................................................................ 48
    Continue Operation ......................................................................................... 48
    Abort Operation ............................................................................................... 49
Moving the Robot Manually ...................................................................................... 50
  Starting the Robot Software in Standalone Mode .............................................. 50
  Opening the Correct INI File ............................................................................. 51
Initializing and Homing the Robot ................................................................. 52
Moving the Robot .......................................................................................... 53
Moving the Robot to an Instrument Position ................................................. 55

Teaching the Robot ....................................................................................... 56
Overview ....................................................................................................... 56
Teaching the Twister II Storage Racks .......................................................... 56
Teaching the Instrument Positions ................................................................. 64
Example: Sciclone Position Numbers and Locations .................................... 77
Example: Teaching the Clear Path for the Sciclone ...................................... 78
Teaching the XP Robot .................................................................................. 83
Teaching Positions Manually ....................................................................... 83
Testing the Positions and Paths .................................................................... 86

Twister II Hardware ...................................................................................... 89
Overview ....................................................................................................... 89
Robot Axes .................................................................................................... 90
Twister II Robot Parts and Functions .............................................................. 92
Twister II Robot Canister ............................................................................. 92
Rack Position Numbers .............................................................................. 93
Pod Parts and Functions .............................................................................. 93
Twister II Power/Fuse Assembly ................................................................. 98
Optional Components .................................................................................. 98
Assay Engine Twister II Parts and Functions ................................................ 99
Assay Engine Twister II Top View ............................................................... 99
Assay Engine Twister II Rack Position Numbers ........................................ 100
Assay Engine Twister II Power/Fuse Assembly .......................................... 100
Rack Parts and Functions ............................................................................ 102
Communications Cable .............................................................................. 103
Power Cord .................................................................................................. 103

Twister II - Maintenance ............................................................................. 104
Cleaning the Twister II ............................................................................... 104
Cleaning the Rack Base ............................................................................... 105
Changing the Twister II Fuse(s) ................................................................... 105
Changing the Assay Engine Twister II Fuses ............................................. 108
Moving the Twister II .................................................................................. 109
Long-Term Shutdown ................................................................................... 110

Troubleshooting .......................................................................................... 111
Twister II Troubleshooting ......................................................................... 111
Re-Teaching the Storage Positions .............................................................. 113
Re-Teaching the Instrument Positions ......................................................... 113
Adjusting the Instrument Positions ............................................................. 114
Twister II Performance Checks ................................................................... 115
Power Loss During Operation ..................................................................... 116

Appendix A: Software Reference ............................................................... 117
Robot Software ............................................................................................ 117
Robot Software Main Window ...................................................................... 117
Manual Controls Tab ................................................................................... 121
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Teach Tab</td>
<td>123</td>
</tr>
<tr>
<td>Diagnostics Tab</td>
<td>129</td>
</tr>
<tr>
<td>Open Window</td>
<td>130</td>
</tr>
<tr>
<td>Save As Window</td>
<td>130</td>
</tr>
<tr>
<td>Add Instrument from CLARA or iLink Window</td>
<td>131</td>
</tr>
<tr>
<td>Instruments Window</td>
<td>132</td>
</tr>
<tr>
<td>Instrument Name Window</td>
<td>132</td>
</tr>
<tr>
<td>Add Position Window</td>
<td>133</td>
</tr>
<tr>
<td>New Path Window</td>
<td>133</td>
</tr>
<tr>
<td>Plate Location Window</td>
<td>134</td>
</tr>
<tr>
<td>Log Window</td>
<td>135</td>
</tr>
<tr>
<td>Settings Window</td>
<td>136</td>
</tr>
<tr>
<td>Visual Basic Editor Window</td>
<td>137</td>
</tr>
<tr>
<td>VBA Macros Window</td>
<td>138</td>
</tr>
<tr>
<td>About Window</td>
<td>139</td>
</tr>
<tr>
<td>Teach Wizard</td>
<td>139</td>
</tr>
<tr>
<td>Teach Wizard Buttons</td>
<td>140</td>
</tr>
<tr>
<td>Rack Teach Wizard</td>
<td>142</td>
</tr>
<tr>
<td>Instrument Teach Wizard</td>
<td>147</td>
</tr>
<tr>
<td>Stack Storage Software</td>
<td>158</td>
</tr>
<tr>
<td>Stack Storage Main Window</td>
<td>158</td>
</tr>
<tr>
<td>Network Browse Window</td>
<td>160</td>
</tr>
<tr>
<td>Analyze Application Window</td>
<td>160</td>
</tr>
<tr>
<td>Choose CLARA Application Window</td>
<td>161</td>
</tr>
<tr>
<td>Capacity Planning Window</td>
<td>162</td>
</tr>
<tr>
<td>New Stack Storage Configuration Window</td>
<td>164</td>
</tr>
<tr>
<td>Open Configuration Window</td>
<td>165</td>
</tr>
<tr>
<td>Stack Storage Configuration Window</td>
<td>166</td>
</tr>
<tr>
<td>Delete Configuration Window</td>
<td>167</td>
</tr>
<tr>
<td>Runtime Stack Storage Configuration Window</td>
<td>168</td>
</tr>
<tr>
<td>About Stack Storage Window</td>
<td>170</td>
</tr>
<tr>
<td>Appendix B: Twister II Specifications</td>
<td>171</td>
</tr>
<tr>
<td>General Instrument Specifications</td>
<td>171</td>
</tr>
<tr>
<td>Robotic Arm</td>
<td>171</td>
</tr>
<tr>
<td>Physical Performance</td>
<td>171</td>
</tr>
<tr>
<td>Physical</td>
<td>172</td>
</tr>
<tr>
<td>Electrical</td>
<td>172</td>
</tr>
<tr>
<td>Environmental</td>
<td>173</td>
</tr>
<tr>
<td>Index</td>
<td>174</td>
</tr>
</tbody>
</table>
Introduction

This manual explains the Twister II hardware, the Assay Engine Twister II hardware, the Robot software, the Stack Storage software, and the iLink PRO Storage software. This manual is intended for systems using the Robot software in a system controlled by either CLARA or iLink PRO automation control software. If you are using iLink software, see the iLink User’s Manual for information on the Robot software.

The Twister II robot is used to move microplates and lids between instruments in an automated system. The hardware descriptions, Twister II maintenance, and Twister II troubleshooting procedures are included in this manual.

The Caliper Life Sciences Robot software controls the robot, stores all of the taught positions for the robot, and includes the VBA code required to operate the Twister II with the automation control software. This manual includes procedures for setting up the Robot software (in both Standalone and Remote modes), teaching the positions, recovering from errors, and troubleshooting the Robot software.

The Stack Storage software is used with the CLARA automation control software to configure materials in the Twister II storage racks. This manual includes procedures for setting up the material configuration and recovering from errors using the Stack Storage software.

The iLink PRO Storage software is used with the iLink PRO automation control software to configure the materials in the Twister II storage racks. This manual includes the procedure for setting up the initial material layout.

The Software Reference section of this manual includes descriptions of all of the windows in the Robot software, the Robot Teach Wizards, and the Stack Storage software. The iLink PRO Storage software does not have any windows, it only displays the rack graphics in the iLink PRO software.
Robot Software Terminology

This section defines the Robot software terminology that the system operators and integrators must know to operate the Twister II software. System Operators should be familiar with the definitions of positions and paths if they will be re-teaching the Twister II robot positions. System Integrators must be familiar with all of the definitions provided in this section.

If you are using software other than the Caliper Robot software in the system, see the software’s user documentation for details about the software.

Positions

A position is a saved point in space, consisting of one value for each robot axis. When the robot moves to a position, all the axes move to the specified locations. Positions are created using the Teach Wizards or the Twister II Robot software controls. Positions are saved in the Position file (.pos) in the Robot\ICP\ folder.

The Caliper automation control software uses robot positions to successfully move materials into and out of each instrument in the system. The Teach wizard automatically creates all of the necessary positions when you follow the instructions in the wizard. Each instrument in the system has one position with each of the names shown in the table below. If an instrument contains more than one material position, there is one of each position name for each material position.

<table>
<thead>
<tr>
<th>Name</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pick</td>
<td>Where the robot moves to retrieve a material from an instrument. May or may not be the same as the Place position.</td>
</tr>
<tr>
<td>Place</td>
<td>Where the robot moves to place a material into an instrument. May or may not be the same as the Pick position.</td>
</tr>
<tr>
<td>PickClearance</td>
<td>Directly above the Pick position. The robot moves down a small vertical distance <em>directly</em> to the Pick position. When the robot is holding a material in the PickClearance position, the bottom of the material must clear the instrument’s plate locator guides, and must not interfere with the instrument’s operation. May or may not be the same position as PlaceClearance.</td>
</tr>
</tbody>
</table>
When the automation control software sends a command to the robot software to retrieve a material from an instrument, the robot moves through the positions in the following order:

• Moves to the instrument's Safe position
• Executes the Approach Path, if an approach path was defined (see “Paths” on page 19 for more information)
• PickClearance<PositionNumber>
• Pick<PositionNumber>
• (Close grips)
• PickClearance<PositionNumber>
• Executes the Clear Path, if a clear path was defined
• Moves to the instrument's Safe position

When placing a material into an instrument, the sequence above is used, except the Place<PositionNumber> and the PlaceClearance<PositionNumber> positions are used instead of the Pick positions.

<table>
<thead>
<tr>
<th>Name</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>PlaceClearance</td>
<td>Directly above the Place position. The robot moves down a small vertical distance directly to a Place position. When the robot is holding a material in the PlaceClearance position, the bottom of the material must clear the instrument’s plate locator guides, and must not interfere with the instrument’s operation. May or may not be the same position as PickClearance.</td>
</tr>
<tr>
<td>Safe</td>
<td>Position to which the robot moves after picking or placing a material. At the highest vertical position so the robot can rotate without contacting any instrument.</td>
</tr>
</tbody>
</table>
Paths

A path is a sequence of positions used to move the robot into or out of an instrument in the system. The Teach wizard automatically creates the required paths when you follow the instructions in the wizard. These paths are created if you choose No when the wizard asks if the robot is clear to move straight up out of the instrument.

The **Approach Path** is executed when the robot is moving from the Safe position into the instrument.

The **Clear Path** is executed when the robot is moving from the PickClearance or PlaceClearance position out of the instrument to the Safe position.

The Approach and Clear paths both contain the same positions, but the Clear path executes the positions in numerical order (1, 2, 3...) while the Approach path executes the positions in reverse numerical order (... 3, 2, 1).

Position Types

An **Absolute** position is a single robot position, relative to the robot’s Home position. Saving an Absolute position saves the current position of all five axes. The positions created by the Teach wizard are all Absolute positions. Most users only need to use the Teach Wizards in the Twister II robot software to create the required positions and paths.

A **Relative** position is used to move the robot a set number of steps, on each axis, relative to the last Absolute position reached. Relative positioning should be used only by advanced users. Most users only need to use the Teach Wizards in the Twister II robot software to create the required positions and paths.

All positions are saved in the Position (.pos) file with the same name as the INI file.
Robot Procedures

A Robot Procedure is a group of Visual Basic macros that control the movement of the robot. Macros group multiple positions and actions together in a sequence. The Teach wizards automatically create the required procedures and macros.

The system integrator can create their own procedures using the VBA editor but must have appropriate VBA instruction before creating macros or procedures. This manual is not intended to substitute for VBA training.

Procedures (and the associated macros), are saved in the Procedure (.xpd) file with the same name as the INI file.

Robot Files

The Robot software uses INI files to store the robot settings and to locate the proper .pos and .xpd files to use when operating the robot. When you open an INI file in the Robot software, the main window displays the positions and paths in the .xpd and .pos files with the same names as the .ini file. The association of the .ini files with the .xpd and .pos files enables you to use multiple robots in the same system.

The following table describes the types of robot files and the contents of each file:

<table>
<thead>
<tr>
<th>File Extension</th>
<th>File Content</th>
</tr>
</thead>
<tbody>
<tr>
<td>.xpd</td>
<td>Stores robot procedure information.</td>
</tr>
<tr>
<td>.pos</td>
<td>Stores robot position information.</td>
</tr>
<tr>
<td>.ini</td>
<td>Stores robot operation information, including which .xpd and .pos files to use.</td>
</tr>
</tbody>
</table>

Robot.ini File

When you open the Robot software in **Standalone mode**, the main window displays the settings in the default .ini file named TwisterII.ini, and uses the data in the TwisterII.xpd and TwisterII.pos files. After opening the Robot software, you can open a different INI file which uses the data in the .xpd and .pos files with the same name as the INI file.

When the Robot software is started in **Remote mode** by the automation control software, the automation control software automatically opens the INI file with the same name as the robot resource to control the robot.
Each robot in the automated system must have an **INI** file with a unique name that matches the name of the robot in the automation control software. This ensures that each robot uses different **XPD** and **POS** files and communicates on a different comm port.

Two default INI files are installed with the Robot software: TwisterII.ini and XPRobot.ini. The TwisterII.ini file contains default parameters to operate the Twister II robot. The XPRobot.ini file contains parameters to operate the XP robot. You can use the default INI files as a template to create multiple robot resources with different names, as described below.

**Example:** If a Twister II robot resource will be named “Robot” in the automation control software, you must create an INI file named Robot.ini before you add the robot to the automation control software. See “Create a New Robot Project” on page 25 for more information on creating new robot INI files. After the robot INI file is created, you can add the robot to the automation control software.

Any changes necessary to the parameters in the **INI** file should be made in the Robot software main window. Do not manually edit the INI file, unless specified in the instructions in this manual.

**Storage Configuration using Stack Storage Software**

The Stack Storage software for the Twister II racks is used with the CLARA automation control software. You use the Stack Storage software to set up the storage configuration, view the storage configuration during a run, and to recover from errors during material processing.

The storage configuration shows where the materials need to be placed in the racks before starting to run a CLARA application. The storage configuration is based on the CLARA application, so the CLARA method must be created and scheduled/sequenced before the storage configuration can be created.

The Stack Storage software enables you to create a configuration where each material is in a separate rack (group by name) or where materials of the same type are grouped into the same racks (group by type). See “Stack Storage Setup” on page 29 for information on creating the storage configuration.
Material Layout using iLink PRO Storage Software

The iLink PRO Storage software for the Twister II racks is used with the iLink PRO automation control software to set up the initial material layout. The initial material layout shows where to place the materials in the racks before starting to run an iLink PRO method.

The iLink PRO Storage software enables you to place multiple material in the same rack, as long as all the materials are the same type, and each has a unique name. See “iLink PRO Storage Setup” on page 35 for information on creating the initial material layout.

Restacking

The Caliper Life Sciences Robot software, the Stack Storage software, the iLink PRO Storage software, and the Caliper automation control software can be used to automatically restack the materials from the destination racks back into the original source racks. This enables you to execute methods in the automation control software that use the same starting rack positions for materials. Restacking with CLARA is explained in the CLARA User’s Manual. Restacking with iLink PRO is explained in the iLink PRO User’s Manual.

Lids

The Robot software, Stack Storage software, iLink PRO Storage software, and Caliper automation control software are designed to accommodate materials with lids. To use materials with lids, the CLARA or iLink PRO method must be created properly. See the CLARA User’s Manual or the iLink PRO User’s Manual for instructions on processing materials with lids.

Remote and Standalone Modes

The Robot software can operate in either Standalone mode or Remote mode.

- The Robot software is in **Standalone mode** if it is opened manually from the Start menu or the desktop.
- The Robot software is in **Remote mode** if it is opened by automation control software such as CLARA.

The Robot software must be in Remote mode when the robot is controlled by the automation control software.
Operation

This section explains how to set up and operate the Robot and Stack Storage software (for a CLARA system) or iLink PRO Storage software (for an iLink PRO system). The Robot Software Setup procedures are included here for reference. For detailed step-by-step installation instructions, see the Robot Installation Instructions (on the installation CD) to set up the robot hardware, set up the robot software, and to teach the instrument positions.

This manual does not contain detailed information on using the automation control software, only an overview of the process. For instructions specific to the CLARA software, see the CLARA User’s Manual. For instructions specific to the iLink PRO software, see the iLink PRO User’s Manual.

This section is divided into the following sections:

• Robot Software Setup (see page 23)
• Stack Storage Setup (see page 29)
• iLink PRO Storage Setup (see page 35)
• Running the Robot with CLARA (see page 42)
• Error Recovery (see page 45)

WARNING

Always keep body parts, hair, jewelry, and clothing away from the robot while it is operating to prevent injury. Keep all objects out of the path of the robot arm.

Robot Software Setup

The Twister II software setup procedures must be performed before integrating the robot with the other instruments in the system and with the Caliper automation control software. The following procedures describe how to set up the Robot software:

1 Start the Robot software (see page 24)
2 Create a new project (see page 25)
3 Configure the robot software (see page 26)
4 Initialize and home the robot (see page 27)
5 Customize the user interface, if desired (see page 28)

Each of these steps are discussed in detail in this section.
Start the Robot Software

To set up and configure the Robot software, you must open the Robot software in standalone mode. For more information on standalone and remote modes, see “Remote and Standalone Modes” on page 22.

To start the Robot software in standalone mode:

1. Manually position the robot arm so there is a clear path straight up to vertical home. (If you don’t have the robot hardware installed, go to step 3.)

2. Turn on the robot power switch.

3. On the Windows task bar, select Start → All Programs → Caliper Life Sciences → Instruments → Caliper Life Sciences Robot → Caliper Life Sciences Robot. The Robot software starts and the main window opens, as shown in Figure 1.

![Figure 1. Robot Software Main Window](image)
Create a New Robot Project

The name of the robot in the automation control software must match the name of the Robot project, which is the same as the name of the robot INI file.

The Robot software displays an untitled project file when the software opens. To create a new project, which is used by the automation control software to control the robot:

1. In the Robot software, select **File**→**New** to open a new project file. (All new projects use the TwisterII.ini file as a template. If you are using an XP robot, you should copy the files out of the \ICP\XP Templates\ folder and paste into the \ICP\ folder, and then open the XPRobot.ini file to use as a template.)

2. Choose **File**→**Save As** to open the Save As window.

3. Navigate to the \ZyRobot\ICP folder.

4. Type the desired name for the file in the **File Name** text box. Remember that the file name must match the name of the robot resource in the automation control software.

5. Click the **Save** button. The Robot project is saved and the project name and path displays in the title bar.

**NOTE**

*If you create a new project, and want to use that project during operation with Caliper automation control software, the name of the robot resource in the Caliper automation control software must be the same as the INI file name. An .ini file name mismatch with the resource name will prevent communication between the Caliper automation control software and the robot.*

When the project is saved, the Robot software stores the robot data in all appropriate files of the same name. For example, changes to the TwisterII project are saved in **TwisterII.ini**, **TwisterII.xpd**, and **TwisterII.pos**.
Configure the Robot Software

You must set the simulation mode and the Comm port for each robot in the system. These settings are specific to the currently open project. Make sure the correct project is open in the Robot software.

To set the robot comm port:

1. On the Robot main window, select Configuration→Settings. The Settings window opens as shown in Figure 2.

![Figure 2. Settings Window]

2. Select the desired Simulation setting, either On or Off. Simulation Off enables communication with the robot. Simulation On simulates communication with the robot and does not move the robot.

3. Select the number of the Comm port that the robot is connected to on the computer. (If you are using simulation mode, the Comm port is not used.)

4. Click the Apply button to apply the settings and close the Settings window.

5. To save the changes, select File→Save.

If there are multiple robots in the system, you must set the Comm ports for the additional robots:

1. Select File→Open, select the .ini file for the next robot, and click the Open button. A Save dialog opens if there are unsaved changes to the currently open project.

2. Click Yes if you want to save the changes to the last robot settings.

3. Open the Settings window and set the Comm port for the robot.

4. Repeat for all robots in the system.

See “Initialize and Home the Robot” on page 27.
Initialize and Home the Robot

The robot must be initialized and homed before use, whether Simulation is On or Off. If Simulation is off, you MUST initialize and home the robot each time the robot power is turned on or the robot software is restarted.

1. On the Manual Control tab, click the Initialize button shown in Figure 3.

**WARNING**

*Home All Axes* moves the robot from the current position to the home position. Be sure there is nothing in the way of this move before executing the command to prevent a robot crash and spilling the material contents.

2. Click the Home All Axes button, shown in Figure 3. This command moves the robot to the home position of each axis:
   - Vertical - Arm lifts to highest position.
   - Reach - Arm fully retracts.
   - Rotary - Robot rotates to a position above rack 2.
   - Wrist -
     - **Twister II**: The wrist rotates the grips to a position perpendicular to the robot arm.
     - **XP Robot**: The wrist rotates the grips to a position parallel to the work surface.
   - Grip - Grips open.
   - Track - If the robot is mounted on a track, the robot moves to the beginning of the track.
Error Message

If the following error message displays, the software is unable to establish communication with the robot.

![Initialization Error Window]

*Figure 4. Initialization Error Window*

Verify that all hardware connections described in the robot installation instructions are correctly installed, and the appropriate simulation mode and Comm port are set in the **Settings** window.

Customize the User Interface

If desired, you can customize the tool bars in the Robot software. Use the down-arrow icons on the tool bars to access the Customize Tool bars menu. See the Windows Help file for instructions on customizing tool bars.
Stack Storage Setup

This section is only for systems using a Twister II robot with the CLARA software. The XP robot does not use the Stack Storage software. If you are using iLink, see the iLink User’s Manual. If you are using iLink PRO and the iLink PRO Storage software, see “iLink PRO Storage Setup” on page 35.

The Stack Storage software must be used to create a storage configuration before the materials are processed in the automation control software. To create the storage configuration, the Stack Storage software collects material data from the specified CLARA application, and uses that data to compile a configuration.

This section provides instructions for creating the storage configurations.

Setting up a Storage Configuration

The Stack Storage software is used in CLARA systems to set up the initial locations of the materials in the Twister II racks. The storage configuration is based on the CLARA application, and you only have to create the storage configuration file the first time you run the CLARA chain. Before setting up the storage configuration, you must have already created the desired CLARA method and then scheduled or sequenced the method as desired. (See the CLARA User’s Manual for details on using the CLARA software.)

To set up a storage configuration:

1. Create and schedule or sequence the desired method(s) in the CLARA Editor software.

2. Verify the CLARA applications you want to set up are loaded (chained, for CLARA 2.2 or greater) and open in the Execution Manager software.

3. Initialize the application in the CLARA Execution Manager software. All of the instrument software for the application or chain are started in Remote mode by CLARA.

4. Click the Stack Storage software button on the Windows task bar. The Stack Storage main window opens. If an application has been created in CLARA, the Configuration option is available as shown in Figure 5 on page 30.
Setting up a Storage Configuration (Continued)

5 Select **Configuration → New**. If CLARA is installed on a different computer than the Stack Storage software, a browse window opens as shown in Figure 6.

![Figure 5. Stack Storage Software Main Window](image1)

![Figure 6. Browse for Computer Window](image2)

Locate the computer where CLARA is installed, select the computer name, and click the OK button.
Setting up a Storage Configuration (Continued)

6 The Choose CLARA Application window opens (see Figure 7) and displays the applications that have been created in CLARA. Do not create a storage configuration for Restack applications. See the CLARA User’s Manual for instructions on creating applications to restack the materials after a method.

![Figure 7. Choose CLARA Application Window](image)

7 Select the application you want to configure.

8 Select how you want to group the materials, either by Name or by Type (see below and on page 32 for details and examples).

NOTES

- When using multiple source racks, you must fill the first source rack before using the next source rack.
- Each plate type must have its own source and destination racks.

a Name - Group materials by name if you want to stack the materials based on the name of the material in your CLARA application. The Stack Storage software places all the materials of one name together, adding an empty “output” rack between material groups.

Example:

‘Material1’ is a Polystyrene, 96microplate, flat bottom plate.
‘Material2’ is a Polystyrene, 96microplate, flat bottom plate.

Grouping by name creates a configuration with all Material1 grouped together and all Material2 grouped together; i.e., each material name is assigned to a different rack.
Setting up a Storage Configuration (Continued)

**NOTE**

![Warning symbol]

*Each plate type, when grouped by name, is assigned its own source and destination racks.*

**b** **Type** - Group materials by type if you want to stack the materials based on the material types in the CLARA application. The Stack Storage software configures all the materials of one type together, adding an empty “output” rack between material types. Material names are not considered in the grouping.

**Example:**
Material1 is a “Polystyrene, 96microplate, flat bottom” material.
Material2 is also a “Polystyrene, 96microplate, flat bottom” material. (Use this option to process lids by naming the lid Material2.)

Grouping by type configures the racks with both materials together. Material1 and Material2 are stacked together in the same rack. When using this method to stack materials with lids, CLARA can move the plates and lids to different locations because the material names are different.

**Example:**
‘Material1’ is a Polystyrene, 96microplate, flat bottom material.
‘Material2’ is a Polyethylene, 96deepwell, flat bottom material.

Grouping by type configures the racks with each material in its own rack and with its own output rack. In this case, a minimum of two pods (four racks) is required.

**NOTE**

![Warning symbol]

*Each plate type must have its own source and destination racks.*

When using multiple plate types, you must fill the first source rack before placing any materials in the next source rack. It is the user’s responsibility to place the materials in the racks properly, based on the CLARA application.
Setting up a Storage Configuration (Continued)

9 Click the **OK** button. The Stack Storage software begins compiling the storage configuration. The **Analyzing CLARA** window opens.

![Analyzing CLARA Application Window](image1)

**Figure 8. Analyzing CLARA Application Window**

10 Once the Stack Storage software has analyzed the CLARA application, the **Capacity Planning** window opens (see Figure 9). This window displays the number of racks in the system and the maximum capacity of one rack for each material in the method.

![Capacity Planning Window](image2)

**Figure 9. Capacity Planning Window**

11 If necessary, edit the number in the **Racks** column to match the rack numbers in the system. Make sure the rack numbers match the rack numbers that were taught in the Robot software. Options are: 1 -3, 1- 6, or 1- 9.

12 Verify the **Max Capacity** column shows the actual number of materials that will fit in the rack when the rack is full (see Figure 9). The default displayed by the software in the Max Capacity column is an estimate based on the specifications of the material. **Make sure the specified number of materials will fit in the rack without extending above the top of the rack.**

When using plates with lids (defined as two different materials with different names but the same material type), count the number of plates plus the number of lids. The total stack of materials MUST be below the top of the rack.
Setting up a Storage Configuration (Continued)

13 For any tip boxes, enter the height (in millimeters) of the tip box base in the **Tipbox Base Height** column. For material specifications, see the manufacturer’s documentation.

14 Click the **OK** button. If there are not enough racks in the system for all of the materials required by the application, an error message opens as shown in **Figure 10**.

![Figure 10. Rack Error Message](image)

Click the **OK** button to close the error message and re-configure the racks. Be sure to enter an accurate material count per rack. If you are still unable to fit the materials into the racks, you must sequence or schedule the application for fewer runs in the CLARA software.

15 The **New Stack Storage Configuration** window opens as shown in **Figure 11**.

![Figure 11. New Stack Storage Configuration Window](image)
Setting up a Storage Configuration (Continued)

The Stack Storage Configuration window displays a graphical representation of the materials in the Twister II racks. If an application returns a material to a storage rack, there will be one empty rack per material type. Verify the configuration is correct and click **OK**. If corrections are required, click **Cancel** to close the configuration without saving and return to the main window.

16 Repeat this process for other methods, if other methods are to be run consecutively, or chained, in CLARA.

Your storage configurations are now compiled, and you are ready for system operation.

iLink PRO Storage Setup

This section is for systems using a Twister II robot with the iLink PRO software. If you are using iLink, see the *iLink User’s Manual*. If you are using CLARA and the Stack Storage software, see “Stack Storage Setup” on page 29.

The iLink PRO Storage software is used to create the initial material layout in the iLink PRO software before creating the method. You create the initial material layout in the iLink PRO Editor. The *iLink PRO User’s Manual* describes how to create a new method.

This section provides instructions for adding the materials to the Twister II racks.

Adding Materials to the Twister II Racks in iLink PRO

When you create a new method in iLink PRO and the iLink PRO Storage resource is added to the iLink PRO software, the graphic below is displayed in the iLink PRO initial material layout.

![Figure 12. iLink PRO Storage](image)
Adding Materials to the Twister II Racks in iLink PRO (Continued)

To add materials to the Twister II racks:

1. Click the desired consumable icon and drag it to the desired rack.

2. When you drop the material onto a rack location, the Material Name window opens as shown in Figure 13.

![Figure 13. Material Name Window](image)

3. In the **Name** text box, type a name for the material. Note that when adding multiple materials to the same Twister II storage rack, the materials are sorted alphabetically, with the name closest to Z appearing at the top of the stack. To add materials correctly, you must add materials alphabetically, starting with the name closest to A.

4. Click the **OK** button to add the material to the rack.

5. If the same material is located in more than one rack at the beginning of the method, click on the material in the rack and drag the material to the next rack.

![Figure 14. Multiple Racks for One Material](image)

6. If the method moves the plates to an empty Twister II rack during the method, you must define an output rack:
   a. Drag the material from the last input rack to the output rack.
   b. Drag the **Make Output** icon onto the output rack as shown in Figure 15.
Adding Materials to the Twister II Racks in iLink PRO
(Continued)

If the method discards the material to a waste location or puts it into a different storage instrument instead of placing it into an empty rack, you do not need to define an output rack.

7 If a method uses **more than one material in the same Twister II rack**, for example, plates with lids or 4 empty daughter plates, drag the additional plates into the racks one at a time, following steps 1 through 6 for each material.

If a method uses **more than one material in the same rack**, the materials must physically be stacked in the order in which the method uses the materials. The integrator must specify the order of multiple materials in the same rack for operators. Only the exact same plate type and part number can be in a rack, with the exception of lids.

**Example:** If you are placing 96 well plates into a rack, you may only place that type of plate, and its lids, into that rack. Specifically, **two plates with the same specifications but from different manufacturers may not be used in the same rack**. Daughter A and Daughter B plates, if they are in the same rack, must be the same plate type, from the same manufacturer, with the same part number.

See “**Example: Adding Multiple Materials to Twister II Racks**” on page 38 for a step-by-step procedure to add multiple plates to multiple Twister II racks in the iLink PRO software.
Example: Adding Multiple Materials to Twister II Racks

This example demonstrates how to add three plates with different names to the same Twister II racks. The plate names will be Mother, Daughter, and Destination. All three plates must be the same plate type.

The plates MUST be added in alphabetical order as follows:

1. Daughter
2. Destination
3. Mother

If the plates are not added in alphabetical order, the initial material setup will not be correct.

To add the materials:

1. Drag the desired material for Daughter to Storage Rack 1. The Material Name window opens.

![Figure 16. Material Name Window](image)

2. Type Daughter in the text box and click the OK button.

3. Drag the Daughter plate from rack 1 to rack 2.
Example: Adding Multiple Materials to Twister II Racks (Continued)

4 Drag the Daughter plate from rack 2 to rack 3.

![Drag from Rack 2 to Rack 3](image)

**Figure 17. Twister II Output Rack**

5 Drag the Make Output icon onto rack 3. The layout for Daughter is complete. Now you need to add the Destination plate.

![Drag and Drop to Rack 2](image)

**Figure 18. Twister II Output Rack**

6 Drag the material for Destination to Storage Rack 1. In this example, Destination must be the same type as Daughter. The Material Name window opens.

7 Type Destination in the text box and click the OK button.

8 Drag the Destination plate from rack 1 to rack 2. Notice that the colored outline around the plate in Rack 1 changes color to indicate a different material.
Example: Adding Multiple Materials to Twister II Racks (Continued)

9 Drag the Destination plate from rack 2 to rack 3.

Figure 19. Twister II Output Rack

10 Drag the Make Output icon onto rack 3. The layout for Destination is complete. Now you need to add the Mother plate.

Figure 20. Twister II Output Rack

11 Drag the material for Mother to Storage Rack 1. In this example, Mother must be the same type as Daughter. The Material Name window opens.

12 Type Mother in the text box and click the OK button.

13 Drag the Mother plate from rack 1 to rack 2.
Example: Adding Multiple Materials to Twister II Racks (Continued)

14 Drag the **Mother** plate from rack 2 to rack 3.

![Figure 21. Twister II Output Rack](image1)

Drag from Rack 2 to Rack 3

15 Drag the **Make Output** icon onto rack 3. The layout for Mother is complete.

![Figure 22. Twister II Output Rack](image2)

16 Click the **Done** button to finish the initial layout.
Running the Robot with Caliper Automation Control Software

The section contains procedures that are used when running the robot in a Caliper automation control software system.

Starting the Robot Software in Remote Mode

To start the required software and initialize the hardware when using the Caliper automation control software:

1. Turn on the Robot power before starting the automation control software.

**WARNING**

When the robot is switched on, it may move. Ensure that you and any obstructions are out of the way of the arm before switching on the robot to prevent injury.

2. If using CLARA, open the CLARA Execution Manager, load (chain) the applications you want to run, create the system, and initialize the instruments. See the *CLARA User’s Manual* for details.

   If using iLink PRO, the instruments initialize automatically when you start the iLink PRO software. See the *iLink PRO User’s Manual* for instructions on starting and initializing resources in the iLink PRO software.

   The automation control software starts the Robot and Stack Storage or iLink PRO Storage software in Remote mode.

**NOTE**

- Do not use or close the Robot, Stack Storage, or iLink PRO Storage software while it is running in remote mode. The automation control software must have complete control over the instrument software during application execution. The automation control software opens and closes the ICPs and Adapters at the appropriate times.

- Once a run is started, do not add or remove plates from instruments or racks, and do not interfere with the movement of the Twister II arm.
Loading the Materials into the Twister II Racks

**WARNING**

*When using this unit with flammable liquids, follow your local SOP to avoid any safety hazards or damages.*

**WARNING**

*Reagents used in processing activities with the Twister II may be corrosive, radioactive, flammable, and/or toxic. Refer to the MSDS (Material Safety Data Sheet) for detailed information.*

- Avoid direct contact with spilled liquid.
- Wear protective gloves and safety glasses.
- Dispose of liquid, containers, and tips properly.
- Make sure that the waste container is large enough to hold all of the waste generated.

To load the materials into the Twister II racks:

- Place the materials in the racks in the correct locations. (Refer to “Appendix B: Twister II Specifications” on page 171 for materials supported.) In CLARA the materials may be grouped by name or by type. In iLink PRO, the materials must be in the order they are accessed from the racks in the iLink PRO method.
- Make sure the Output racks are empty.
- Verify well A1 is correctly located for *all materials*.
- Make sure the number of materials in the racks equals the number of runs to be executed by CLARA. (The number of runs to be executed may differ from the number of runs scheduled.) Any discrepancy in the material count will result in a CLARA error. See the CLARA User’s Manual for details on running CLARA applications.

3 In CLARA, to monitor the materials in the Twister II racks, see “Viewing the Material Positions while a CLARA Application is Running” on page 44.

4 If an error occurs while moving a material, see “Error Recovery” on page 45.
Viewing the Material Positions while a CLARA Application is Running

You can use the Stack Storage software to view the current positions of the materials in the racks while a CLARA application is running. The positions are updated as the materials are moved from and to the racks.

To view the current material positions:

1. While the CLARA application is running, the View menu on the Stack Storage main window is enabled.

2. Select View → Runtime. The Runtime Stack Storage Configuration window displays the current position of the materials in the Twister II racks as shown in Figure 23 on page 44.

![Figure 23. Runtime Stack Storage Configuration Window](image)

The material positions and the rack data columns update in real time as the materials are moved. For information on using the controls in the Runtime window, see “Error Recovery” on page 45.
Error Recovery

The Caliper automation control software generates alarms to notify the user when an error status is returned from a resource. For information on the various types of alarms, please see the CLARA User’s Manual or the iLink PRO User’s Manual.

If a Suspend alarm is generated, that alarm is recorded in the log file, displayed in the Alarm window, and execution is suspended until the user chooses the desired error recovery option.

The error recovery options are:

• Retry the instruction.
• Continue from the next instruction.
• Abort the application.

Using the Robot Software and the Stack Storage Software during Error Recovery

If an error occurs while a CLARA application is running, and the robot is moving a material when the error occurs, you may have to use the Robot software to move or re-position the robot before you can Retry, Continue, or Abort the run.

If the robot is moving a material to or from the Twister II racks when an error occurs, you should view the current material positions in the racks. You may need to adjust the material configuration before you can resume the run, depending on which recovery option you want to choose.

This section shows some possible error scenarios and describes the recovery options.

Errors During a Move Instruction

If the error occurs during a move from a Twister II rack to another instrument in the system:

1 Leave the error displayed in the CLARA software. (This ensures that no new instructions begin executing while you recover from the error.)

2 Click the Robot Software button on the Windows task bar to display the Robot software.
Errors During a Move Instruction (Continued)

3 If the robot is still holding the plate, use the Manual Controls tab in the Robot software to release the plate and move the robot arm to it’s highest vertical position. You may need to initialize the robot first, if the Robot software is in an error state. (For instructions on using the Manual Control tab, see “Moving the Robot Manually” on page 50.)

4 Click the Stack Storage button on the Windows task bar to display the Stack Storage software.

5 If the Runtime Stack Storage Configuration window is not displayed, select View→Runtime on the Stack Storage main window.

6 Use the buttons on the Runtime Stack Storage Configuration window to adjust the material positions based on where you will be placing the material. For example: If you will be placing the material back into rack 1 to retry the Move, click the + button under rack 1 to add one more material to rack 1.

   If you are going to place the material into the instrument and the Runtime Stack Storage Configuration window is displaying the correct information, minimize the Stack Storage software.

**NOTE**

![danger]

A Move to an instrument may include some commands sent to the instrument as part of the move, such as opening the instrument drawer or moving the instrument to a Safe position. Make sure that you manually send these commands to the instrument if you choose to Skip the Move.

7 Manually prepare the instrument if necessary. If the instrument is not in the correct state to receive the material or start the Move, use the instrument’s software to prepare the instrument.

8 In CLARA, choose Skip to skip over the instruction that generated the error or choose Retry to retry the instruction that generated the error.
If the error occurs during a move from a Twister II rack to another Twister II rack:

1. Leave the error displayed in the CLARA software. (This ensures that no new instructions begin executing while you recover from the error.)

2. Click the Robot Software button on the Windows task bar to display the Robot software.

3. If the robot is still holding the plate, use the Manual Controls tab in the Robot software to release the plate and move the robot arm to its highest vertical position. You may need to initialize the robot first, if the Robot software is in an error state. (For instructions on using the Manual Control tab, see “Moving the Robot Manually” on page 50.)

4. Click the Stack Storage button on the Windows task bar to display the Stack Storage software.

5. If the Runtime Stack Storage Configuration window is not displayed, select View → Runtime on the Stack Storage main window.

6. Use the buttons on the Runtime Stack Storage Configuration window to adjust the material positions based on where you will be placing the material.

For example: If you will be placing the material back into rack 1 to Retry the Move, click the + button under rack 1 to add one more material to rack 1.

If the material is still shown in rack 1 and you want to manually place the material into rack 2 and Skip the current Move instruction, click the - button under rack 1 to remove one material from rack 1, then click the + button under rack 2 to increase the number of materials in rack 2.

7. In the CLARA software, select the desired recovery option, either Skip or Retry.
Retry Operation

If the error can be corrected, and you want to correct it and perform the CLARA instruction again, use Retry. To retry the instruction, return all instruments and materials to the state prior to the instruction:

1. Move the robot to a safe position. The arm must be at vertical top, away from the rack or instrument.

2. Physically place the material into the position it was in before the instruction that caused the error.

3. Put the other instruments in the system into the state they were in at the end of the previous instruction using the ICP for each instrument.

4. Open the Stack Storage software Runtime View window. Use the +/- buttons to put the materials in the positions they were in before the error.

5. Choose the Retry option in the CLARA software.

Continue Operation

If the error can be corrected manually and you want to start the application with the next instruction, use Continue. To continue, set up the instruments and materials in the state required if the instruction that caused the error had completed:

1. Move the robot to a safe position. The robot arm must be at vertical top, away from the rack or instrument.

2. Verify the material is in the position it would hold if the instruction had completed.

3. Verify the other instruments in the system are in the state they would be in if the instruction had completed.

4. Open the Stack Storage software Runtime View window. Use the +/- buttons to put the materials in the positions they would be in after the instruction that caused the error.

5. Choose the Continue option in the CLARA software.
Abort Operation

If you cannot fix the cause of the error and want to stop execution of the application, choose **Abort**. The application can be started from the beginning, after re-loading the materials into the positions required to start the application from the beginning. All output racks must be empty, and the input racks must be properly loaded. See the *CLARA User’s Manual* for instructions on recovering applications.
Moving the Robot Manually

This section describes how to operate the robot manually in Standalone mode (not running under automation control software).

The instructions for using the Manual Control tab (see “Moving the Robot on page 53 or “Moving the Robot to an Instrument Position” on page 55) can also be used to move the robot in Remote mode when the automation control software is paused. Usually the only reason to move the robot when in Remote mode is during error recovery. See “Error Recovery” on page 45 for more details on error recovery.

Starting the Robot Software in Standalone Mode

If you want to move the robot using the Robot software without the robot being controlled by the automation control software, you can start the Robot software in Standalone mode.

To start the Robot software in standalone mode:

1. Manually position the robot arm so there is a clear path straight up to vertical home. (If you don’t have the robot hardware installed, go to step 3.)

2. Turn on the robot.

3. On the Windows task bar, select Start→Programs→Caliper Life Sciences→Instruments→Caliper Life Sciences Robot→Caliper Life Sciences Robot. The Robot software starts and the main window opens, as shown in Figure 24.

![Figure 24. Robot Software Main Window](Image)
Opening the Correct INI File

When operating the robot in Standalone mode, you must manually open the robot INI file that contains the correct settings and positions for the robot.

To open the desired INI file:

1. In the Robot software, select **File → Open** to open the Open window (see Figure 25).

![Figure 25. Open Window](image)

2. Select the desired project (INI) file. (Select the INI file with the correct Comm port setting and positions and paths that were taught for the system.)

3. Click the **Open** button to open the project file and display the robot settings, positions, and paths.
Initializing and Homing the Robot

Initializing the robot establishes communication between the robot and the robot software and loads the settings from the INI file. You must have the correct INI file open to initialize the robot.

To initialize the robot:

1. On the Robot software main window, click the Manual Control tab.

2. On the Manual Control tab, click the Initialize button.

**WARNING**

*Home All Axes* moves the robot from the current position directly up to vertical home. Be sure there is nothing in the way before clicking the Home All Axes button to prevent a crash and spilling the material contents.

3. Click the **Home All Axes** button. This command moves the robot to the home position of each axis:
   - Vertical - Arm lifts to highest position.
   - Reach - Arm fully retracts.
   - Rotary - Robot rotates to a position above rack 2.
   - Wrist -
     - **Twister II:** The wrist rotates the grips perpendicular to the robot arm.
     - **XP Robot:** The wrist rotates the grips parallel to the bench.
   - Grip - Grips open.
   - Track - If the robot is mounted on a track. the robot moves to the beginning of the track.
Moving the Robot

You use the Manual Controls tab to move the robot in Standalone mode or while recovering from an error when the automation control software is paused.

To use the Manual Controls tab:

1. Click the **Get Current Position** buttons to display the current robot position on each axis.

2. If desired, change the **Speed** for any axis to the desired setting.

**NOTE**

- Moving the robot too fast with a filled plate may spill the contents of the plate.
- The robot moves to the selected positions on the Manual Control tab without checking for obstacles. Make sure the path to the selected position is clear to prevent the robot from crashing.

3. To select the desired position for the robot, either:
   
a. Type the desired numeric position in the **Target Position** text box and then press the Enter key. Hover the cursor over the text box to view the range of motion on each axis.
Moving the Robot (Continued)

b Click the Up or Down arrows next to the Target Position text box. The robot moves immediately when you click the buttons. Hold the CTRL key and click to move the robot 1000 steps. Hold the Shift key and click to move the robot 10,000 steps. Hold the ALT key and click to move the robot 50,000 steps.

c Click the Arrow buttons (Up/Down, In/Out, etc.) to move the robot to the desired position.

d Click on the Jog slider and drag to the desired position on the axis. The robot moves immediately when you release the slider.

4 If necessary, click the Abort Move button to stop a move in progress.

5 If the robot hits anything, such as the racks or another instrument in the system, make sure to move the robot all the way up to vertical home and then click the Home All Axes button to home the robot before moving the robot to any other positions.
Moving the Robot to an Instrument Position

To move the robot to a saved instrument position:

1. On the Robot software main window, click the Teach tab (see Figure 27).

2. Click the name of the instrument that you want to move the robot to in the Names list.

3. If the path to the instrument is not a direct path down into the instrument position (as for the Sciclone), you must use the Approach path to move the robot into the instrument:
   a. Click the Paths tab.
   b. Select the Approach Path for the position number to move to in the Paths drop-down list. (Approach 1 is the approach path to position 1, Approach 2 is for position 2, etc.)
   c. Click the Execute Path button to move the robot through the approach path.
   d. Click the Positions tab to view the instrument positions.

4. Select the position that you want to move to in the Positions list. You should move to the PickClearance or PlaceClearance position before moving to the Pick or Place positions.

5. Click the Move To button to move the robot.

6. If the path out of the instrument is not clear, execute the Clear path for the instrument position to move the robot out of the instrument.

Figure 27. Teach Tab
Teaching the Robot

Overview

This section describes how to teach robot positions using either the Robot Teach Wizard (for use only with Twister II robots) or using the Robot software.

When teaching a Twister II robot, you use the Teach Wizard to teach the robot positions for the Twister II storage racks (see below), and the instruments in the system (see page 64).

When teaching an XP robot, you use the Robot software to teach positions for all of the instruments in the system (see “Teaching the XP Robot” on page 83).

The robot and the instruments must be installed in their permanent locations, and you must know the names of the instruments in the automation control software before teaching the robot.

Teaching the Twister II Storage Racks

You can teach the storage racks with the Robot software in either Standalone mode (started from the Windows Start menu) or in Remote mode (started and initialized by the automation control software).

To teach the Twister II storage racks:

1. If the automation control software is running, start the Robot software in Remote mode. Otherwise, start the Robot software from the Windows Start menu. The Robot software main window displays as shown in Figure 28.
Teaching the Twister II Storage Racks (Continued)

2 If the Robot software is in Remote mode, the INI file with the same name as the robot resource opens automatically.

If the Robot software is in Standalone mode, open the INI file with the same name as the robot that you are teaching, click the Initialize button to initialize the robot, and click the Home All Axes button to Home the robot before teaching.

3 Click the Teach tab on the Robot software main window.

4 Click the Add button below the Names list.
   • If CLARA or iLink PRO is not installed, the Instrument Name window opens. Type the name of the Twister II storage racks in the Instrument Name window and click the OK button. Go to step 5.
   • If CLARA or iLink PRO is installed, the Add instrument from CLARA or iLink window opens as shown in Figure 30.

Figure 29. Robot Teach Tab

Figure 30. Add Instrument from CLARA or iLink Window
Teaching the Twister II Storage Racks (Continued)

- Click the **Yes** button to open the Instruments window (see page 132) and display a list of the resources that have been created in CLARA or iLink PRO. Choose the name of the storage racks from the list and click the OK button. Choosing from the list ensures that the name of the taught positions exactly matches the name of the racks in the automation control software.

- Click the **No** button to open the Instrument Name window and type the desired name for the racks. (This enables you to teach an instrument before it is added to the automation control software. You must make sure that the Resource name in the automation control software and the storage rack name match exactly for the automation control software to use the correct positions.)

5  The Select Teaching Wizard window opens as shown in **Figure 31**.
Teaching the Twister II Storage Racks
(Continued)

6 To teach the Twister II storage racks, click the Yes option and click the OK button. The Rack Teach Wizard Welcome Window opens as shown in Figure 32.

![Figure 32. Rack Teach Wizard - Welcome Window](image)

7 Follow the instructions on the Welcome window and then click the Next button. The Set Speed window opens as shown in Figure 33.

![Figure 33. Rack Teach Wizard, Set Speed Window](image)

8 If desired, adjust the speed that the robot will move at when moving to and from the racks.
Teaching the Twister II Storage Racks (Continued)

9 Click the **Next** button to display the Select Racks window as shown in **Figure 34**.

![Figure 34. Rack Teach Wizard, Select Racks Window](image)

10 Select the check boxes next to the numbers of the racks in the system. You must teach all of the racks in the system. You cannot teach only some of the racks. Rack 1 is always selected.

11 Click the **Next** button. The Place Teach Block window opens as shown in **Figure 35**.

![Figure 35. Rack Teach Wizard, Place Teach Block Window](image)
Teaching the Twister II Storage Racks (Continued)

12 Follow the instructions on the Place Teach Block window:

   a Place the teach block (included with the Twister II) on the top of rack 1. Be sure the teach block rests flat on the top of the rack.

   b Support the Twister II arm.

**WARNING**

*You must support the robot arm before performing the next step! When the robot motors are released, the arm will drop if not supported.*

13 Click the **Next** button. **Do not let the arm drop.** The robot motors release (so that you can move the robot arm manually) and the Teach Rack 1 window opens as shown in Figure 36.

![Figure 36. Rack Teach Wizard, Teach Rack 1 Window](image)

14 Move the robot arm to place the gripper onto the teach plate on rack 1. Make sure the gripper is centered front-to-back and side-to-side. Lift and lower the arm once or twice to ensure the arm is positioned correctly. Then **remove your hands from the arm and teach plate.**
Teaching the Twister II Storage Racks
(Continued)

**WARNING**

Make sure hands and fingers are away from the robot before performing the next step.

15 Click the **Next** button to teach the position. The robot grippers close on the teach plate. If you are teaching more than one rack, the Teach Rack window (shown in Figure 37) displays instructions to teach the next rack.

![Figure 37. Rack Teach Wizard, Teach Rack 2 Window](image)

16 With the robot grippers still holding the teach plate, lift the robot arm by lifting the arm from underneath (not by the wrist or grip). Move the arm to the next rack and fit the teach plate into the top of the rack. Make sure the teach plate fits flat on the top of the rack and is centered on the rack. Lifting and lowering the arm once or twice will ensure the arm is positioned properly.

17 Repeat steps 15 and 16 until all of the rack positions have been taught. When you click the **Next** button after teaching the last rack, the Finish window opens (see Figure 38 on page 63).
Teaching the Twister II Storage Racks
(Continued)

18 Click the Finish button. The Save Changes window opens as shown in Figure 39.

19 Click the Yes button to save the positions. The Rack Teach Wizard closes and the Robot software main window opens.

20 To permanently save changes, select File→Save to save the robot project.
Teaching the Instrument Positions

You can teach the instrument positions with the Robot software in either Standalone mode (started from the Windows Start menu) or in Remote mode (started and initialized by the automation control software).

To teach an instrument position:

1. If the automation control software is running, start the Robot software in Remote mode. Otherwise, start the Robot software from the Windows Start menu.

2. On the Windows task bar, click the Robot software button to show the Robot software main window.

3. If the Robot software is in Remote mode, the INI file with the same name as the robot resource opens automatically.

   If the Robot software is in Standalone mode, open the INI file with the same name as the robot that you are teaching, click the Initialize button to initialize the robot, and click the Home All Axes button to Home the robot before teaching.

4. Click the Teach tab on the Robot software main window.
Teaching the Instrument Positions (Continued)

5 Click the Add button below the Names list.
   • If CLARA or iLink PRO is not installed, the Instrument Name window opens. Type the name of the instrument in the Instrument Name window and click the OK button. Go to step 6.
   • If CLARA or iLink PRO is installed, the Add instrument from CLARA or iLink window opens as shown in Figure 42.

![Figure 41. Robot Teach Tab](image)

![Figure 42. Add Instrument from CLARA or iLink Window](image)

   • Click the Yes button to open the Instruments window (see page 132) and display a list of the resources that have been created in CLARA or iLink PRO. Choose the name of the instrument from the list and click the OK button. Choosing from the list ensures that the name of the taught positions exactly matches the name of the instrument in CLARA or iLink.
Teaching the Instrument Positions (Continued)

- Click the **No** button to open the Instrument Name window and type the desired name for the instrument. (This enables you to teach an instrument before it is added to the automation control software. You must make sure that the Resource name in the automation control software and the instrument name match exactly for the automation control software to use the correct positions.)

6 The Select Teaching Wizard window opens as shown in Figure 43.

![Select Teaching Wizard Window](image)

**Figure 43. Select Teaching Wizard Window**

7 To teach an instrument, click the **No** option and click the **OK** button. The Instrument Teach Wizard Welcome Window opens as shown in Figure 44.
Teaching the Instrument Positions (Continued)

Follow the instructions on the Welcome window and then click the Next button. The Set Speed window opens as shown in Figure 45.

If desired, adjust the speed that the robot will move at when moving to and from the racks.

Click the Next button to display the Plate Delivery Mode window as shown in Figure 46 on page 68.
Teaching the Instrument Positions (Continued)

11 Choose how the robot moves to the instrument positions: either using the plate sensor in the arm to move down until the sensor is activated, or moving to the specified absolute position. Use the Find Material option unless the instrument position is not stable and the plate sensor does not work properly in the instrument.

12 Click the Next button to display the Number of Locations window as shown in Figure 47.

13 Use the arrow buttons next to the Number of Locations text box to set the number of material locations that the robot will access in the instrument. The default is 1.
Teaching the Instrument Positions (Continued)

14 Click the **Next** button. The Position Number window opens as shown in Figure 48. The “Location 1 of” text on the window indicates how many instrument locations are being taught and which location you are currently teaching.

![Figure 48. Instrument Teach Wizard, Position Number Window](image)

15 Use the arrow buttons next to the **Position Number** text box to set the position number of the location you are teaching. The default is 1. See “Example: Sciclone Position Numbers and Locations” on page 77 for an example where the position number does not equal the location number.

16 Click the **Next** button. The Place Microplate window opens as shown in Figure 49.

![Figure 49. Instrument Teach Wizard, Place Microplate Window](image)
Teaching the Instrument Positions (Continued)

17 Place an empty microplate in the plate location shown in the Place Microplate window. Make sure the plate is flat, flush and as centered as possible.

18 Hold the Twister II arm so it does not drop.

**WARNING**

*You must support the robot arm before performing the next step! When the robot motors are released, the arm will drop if not supported.*

19 Click the **Next** button. The robot servo motors release so you can move the robot arm manually. If you don't hold the robot arm, it will drop. The Teach Location window opens as shown in Figure 50 on page 70.

![Figure 50. Instrument Teach Wizard, Teach Location Window](image)

20 Move the robot arm to the instrument and center the grips over the microplate. Make sure the grip assembly is centered over the microplate and rests flat on the microplate.

21 Click the **Next** button to teach the position to the robot. The robot grippers close on the microplate and the Clearance Position window opens as shown in Figure 51 on page 71.
Teaching the Instrument Positions (Continued)

22 Click the **Move Up 1 CM** button several times until the bottom of the microplate is clear of the plate locator. (If you are moving larger consumables, like deepwell plates, make sure there is enough room for a deepwell plate held in the grippers to clear the plate locator.)

Alternatively: you can lift the robot arm (still holding the microplate), place the tallest material that will be used in the system into the instrument, and then place the microplate (still in the robot grippers) on top of the tallest material. Make sure the microplate is centered over the material and rests flat on the material.

23 Click the **Next** button to teach the position. The Different Pick Position window opens as shown in Figure 52 on page 72.
Teaching the Instrument Positions (Continued)

Figure 52. Instrument Teach Wizard, Different Pick Position Window

24 If the instrument returns the material in a slightly different position than originally placed, select the Yes option to teach a different Pick location for the instrument. If the material is in exactly the same position after it is processed, select the No option.

25 If you selected Yes, do not click the Next button. Continue with step 26 below.

26 Hold the Twister II arm so it does not drop.

WARNING

You must support the robot arm before performing the next step! When the robot motors are released, the arm will drop if not supported.

27 Click the Next button. The robot servo motors are released so you can move the robot manually. Hold the robot arm so it does not drop. The Teach Pick Position window opens as shown in Figure 53.
Teaching the Instrument Positions (Continued)

28 Find the pick location for the material:

a Using the controls on the Robot software main window, and while holding the material, release the grip.

b Place the material into the instrument's material tray or drawer.

c Process the plate with the instrument to position the microplate in the position it will be in after processing.

d Position the robot grips over the microplate. Make sure the grip is centered over the microplate and rests flat on the microplate. Be careful not to move the microplate.

e Using the controls on the Robot software main window, close the grips around the material.
Teaching the Instrument Positions (Continued)

29 Click the **Next** button to teach the position. The Teach Pick Clearance Position window opens as shown in Figure 54 on page 74.

![Figure 54. Instrument Teach Wizard, Teach Pick Clearance Position Window](image1)

30 Click the **Move Up 1 CM** button several times until the bottom of the microplate is clear of the plate locator. (If you are moving larger consumables, like deepwell plates, make sure there is enough room for a deepwell plate held in the grippers to clear the plate locator.)

31 Click the **Next** button to teach the position. The Teach Clearance Path window opens as shown in Figure 55.

![Figure 55. Instrument Teach Wizard, Teach Clearance Path Window](image2)
Teaching the Instrument Positions (Continued)

32 If the robot is clear to move up to its highest vertical position, you do not need to teach a clearance path. Click the Next button and skip to step 34 on page 76.

If the robot is not clear to move up to its highest vertical position, continue with the next step.

33 Teach the clearance path:
Use the Clearance window to teach the path out of the instrument if the robot cannot move directly up to its vertical limit when leaving the material location. The clear path is made up of multiple positions. The robot will move in a direct line from one position to the next. For obstructions directly above the arm, you will usually teach a position to the left or right, and then any additional positions as necessary to clear the vertical obstruction.

**WARNING**

*You must support the robot arm before performing the next step! When the robot motors are released, the arm will drop if not supported.*

a Hold the Twister II arm so it does not drop.

b Click the Disable button to release the robot servo motors so you can move the robot to the desired position. Make sure the robot can reach the next position by moving in a direct line from any material position in the instrument.

c Move the robot to the next position in the clearance path and click the Teach button. The robot servo motors engage when you click the Teach button.

d Repeat steps a through c until the robot arm has a clear path up to the vertical limit.
Teaching the Instrument Positions (Continued)

34 Click the **Next** button on the Teach Clearance Path window. If the instrument has more than one position, go to step 17 on page 70 and repeat the teaching instructions for each position in the instrument. When all of the material positions for the instrument have been taught, the Finish window opens as shown in Figure 56.

![Figure 56. Instrument Teach Wizard, Finish Window](image)

35 Click the **Finish** button. The Save Changes window opens as shown in Figure 57.

![Figure 57. Save Changes window](image)

36 Click the **Yes** button to save the positions. The Instrument Teach Wizard closes and the Robot software main window opens.

37 To permanently save changes, select **File→Save** to save the robot project.
Example: Sciclone Position Numbers and Locations

The Caliper Sciclone ALH 3000 has 20 plate locations on the deck as shown in Figure 58. In the automation control software, the positions are numbered 1 through 20, with 1 in the upper left and 20 in the lower right.

![Figure 58. Sciclone Position Numbers](image)

The Twister II Robot cannot access all positions on the Sciclone. The location of the Twister II robot determines which positions can be accessed.

As an example, if the Twister II Robot is located on the right side of the Sciclone and can reach 5 positions, when teaching the robot using the Instrument Teach wizard:

1. Set the **Number of Locations** to 5 (because that is the number of positions you will be teaching).

2. When teaching each location, change the **Position Number** to match the Sciclone Deck position number as shown above.

When you are teaching the Sciclone, Location 1 might be Position 5, Location 2 might be Position 10, Location 3 might be Position 14, Location 4 might be Position 15, and Location 5 might be Position 20. Although the positions do not need to be taught in any order, you must change the position number to match the Sciclone position you are teaching.
Example: Teaching the Clear Path for the Sciclone

This section shows an example of teaching the Clearance path out of the Sciclone when accessing the Sciclone with the Twister II robot located on the right side of the Sciclone. Remember that the Clearance Path below must be taught for each of the Sciclone positions that the Twister II can access.

To teach the Sciclone Clearance positions:

1. In this example, the Sciclone positions and locations that the robot can access are shown below. Depending on the type of Twister II robot you have and the location of the robot, you must determine which positions your robot can access.

   ![Figure 59. Sciclone Position Numbers](image)

2. Teach the Sciclone deck position as described in the wizard: first with a microplate in the position, then use the Move Up 1 CM to move the plate up to the clearance height and teach the clearance position.

3. Select No in the Different Pick Position window to skip teaching a different pick position.

4. When the Teach Clearance Path window opens as shown in Figure 60, you must teach three clear points for each Sciclone position. The robot will move in a direct line from one position to the next.
Example: Teaching the Clear Path for the Sciclone (Continued)

**WARNING**

You must support the robot arm before performing the next step! When the robot motors are released, the arm will drop if not supported.

5 Hold the Twister II arm so it does not drop.

6 Click the **Disable** button to release the robot motors so you can move the robot to the desired position.

7 Move the Twister II arm (still gripping the microplate) from the Sciclone position that you are teaching straight in toward the Twister II tower.

8 Rotate the arm until the microplate is close to the Sciclone support leg.
Example: Teaching the Clear Path for the Sciclone (Continued)

9 Rotate the robot wrist so that the microplate will clear the Sciclone leg when the arm rotates around the tower (see Figure 61).

![Figure 61. Microplate Clearing Sciclone Leg](image1)

10 Rotate the arm back so it is aligned with the Sciclone position that you are teaching as shown in Figure 62. (Note that you can place a microplate under the arm to support the arm while teaching the position.)

![Figure 62. Sciclone Clear Position 1](image2)

11 The arm should be positioned so that:
   - the plate is slightly higher than the top of the plate(s) on the deck,
   - the arm is aligned with the Sciclone deck position,
   - the arm is fully retracted toward the tower, and
   - the wrist is rotated so the plate will not hit the Sciclone leg when rotating.
Example: Teaching the Clear Path for the Sciclone (Continued)

12 Click the Teach button. The robot motors engage when you click the Teach button and the first Sciclone clear position is saved.

13 Click the Disable button to release the robot motors to teach the second Sciclone clear position. If you did not use a microplate to hold up the Twister II arm, make sure to support the arm before clicking the Disable button.

14 Without rotating the wrist or moving the microplate, rotate the arm so that the microplate is centered between the Sciclone leg and the closest Twister II rack as shown in Figure 63.

![Figure 63. Sciclone Clear Position 2](image)

15 Click the Teach button. The robot motors engage when you click the Teach button and the second Sciclone clear position is saved.

16 Click the Disable button to release the robot motors to teach the third Sciclone clear position. If you did not use a microplate to hold up the Twister II arm, make sure to support the arm before clicking the Disable button.
Example: Teaching the Clear Path for the Sciclone (Continued)

17 Rotate the Twister II wrist (without rotating the entire arm, just the wrist) so the short edge of the microplate is toward the front of the system, and the wrist is straight (aligned with the arm) as shown in Figure 64.

![Figure 64. Sciclone Clear Position 3](image)

18 Click the **Teach** button. The robot motors engage when you click the Teach button and the third Sciclone clear position is saved.

19 Click the **Next** button on the Clearance window.

20 Repeat steps 2 through 19 to teach each of the Sciclone positions.

21 When all of the material positions for the instrument have been taught, the Finish window opens.

22 Click the **Finish** button. The Sciclone positions are saved, the Instrument Teach window closes and the Twister II Robot software main window opens.

23 Save the TwisterII.ini file.
Teaching the XP Robot

You can teach the XP robot using the Teach Wizards in the same way that the Twister II robot is taught (see “Teaching the Instrument Positions” on page 64), or you can teach the positions manually (see below).

When teaching the XP robot, the Twister II storage racks are not used to hold materials and the Stack Storage software is not used to create the initial Storage Configuration. Use the software for the storage instrument where the materials are located at the beginning of the run to set up the initial storage configuration.

Teaching Positions Manually

Advanced users can manually create positions, rather than use the Teach Wizards. By teaching manually, you only create the robot positions in the Robot software, you do not add the VBA code required by the automation control software for full integration between the robot and an external instrument.

This section provides instruction for teaching positions manually. This method may be useful for systems that have customized VBA code.

Additional Position Types

An advanced user can teach two types of positions:

- **Absolute** positions are positions that always cause the arm to return to one exact point in space.

- **Relative** positions are used in processes to calculate a new position. A move to a Relative position causes the robot to move one or more axes some amount relative to a referenced Absolute position. The referenced Absolute position is the last Absolute position you commanded the robot to go to. Relative positioning is a valuable tool that can eliminate the need to create many Absolute positions.

For example:

If

Relative position A = Reach axis of 1000 steps

and

the robot Reach axis is currently at step 500

then

moving to Relative position A moves the robot reach axis to step 1500.
Teaching an Absolute or Relative Position

Absolute positions represent any specific point in space. Absolute positions are especially useful when you need the robot to clear an obstacle before moving to another position.

The teaching method described here teaches with servos enabled. However, a position can be taught by disabling the servos and moving the robot manually to the desired position.

1. Use the Axis controls, on the Manual Control tab, to reach the desired position.

2. Click the Positions tab on the Teach tab and click New.

![Figure 65. Positions Tab](image)

The Add Position window opens as shown in Figure 66.

![Figure 66. Add Position Window](image)

3. Enter the desired position name in the Name text box.

4. Select the position type, Absolute or Relative, from the drop-down list. For more information on position types, see “Additional Position Types” on page 83.

5. Click OK to save the position. The position is displayed in the Positions list.
Edit an Absolute or Relative Position

You may want to re-teach a position (edit position data) manually. Re-teaching is required if you have:

- Switched the pod position of your racks
- Switched the location of your pods
- Relocated the robot or any instrument in your system

Users who want to re-teach positions for instruments using customized VBA code must re-teach positions using the steps provided in this section.

**WARNING**

*Do not use the Teach Wizards to re-teach positions created using version 1 and customized code. Using the Teach Wizards to re-teach these positions will overwrite the customized code for the instrument.*

1. Use the controls on the Manual Control tab to move to the desired position.

2. Click the **Teach** tab on the Robot main window.

3. On the **Names** tab, select the instrument whose position you want to re-teach. The positions display on the **Positions** tab. If you are re-teaching a position retained from V1, select the Robot instrument.

4. Select the position you want to change and click the **Change** button. The position is updated with the current position of the robot.
Testing the Positions and Paths

You should verify the positions for each instrument in the system after teaching. Use the **Test and Verify** tab on the Teach tab in the Robot software (see Figure 68) to test the positions.

![Figure 68. Test and Verify Tab](image)

To verify the positions and paths are correct:

1. Using the controls on the Manual Controls tab, move the robot arm to a safe (vertical and reach axis home) position.

2. Place a material in the instrument position you want to test. If the instrument has multiple material positions, begin by placing the material in position 1.

3. Click the **Teach** tab.

4. Click the **Test and Verify** tab (see Figure 68).

5. Select the instrument you want to test on the **Names** tab (see Figure 68).
Testing the Positions and Paths (Continued)

WARNING

The **GetPlate** command causes the robot to move in one direct motion to the selected position’s Safe position. Be sure there is nothing in the path of the robot arm to prevent a robot crash.

6 Click the **Get Plate** button.

7 If the instrument you are testing does not have multiple material positions, or if your system does not have more than one storage rack, skip to step 9. If the instrument has multiple material positions, the **Location Number** window (or the **Rack Number** window, for Storage) opens (see Figure 69).

![Figure 69. Location Number Window](image)

8 Type the position or rack number you want to test into the text box and click **OK**. Only a valid position number will be accepted.

9 Observe the robot as it moves through the approach path, to the clearance position for that position, and then to the material.

10 If correctly taught, the robot will grip the material, move back to the clearance position, and then move through the clearance path back to the safe position. Skip to step 11.

   If incorrectly taught, reteach the instrument position or path using the appropriate Teach Wizard (see “Teaching the Instrument Positions” on page 64), and return to step 2.

11 Verify the robot arm is in a safe (vertical and reach axis home) position.

WARNING

The **PutPlate** command causes the robot to move in one direct motion to the selected position’s Safe position. Be sure there is nothing in the path of the robot arm to prevent a robot crash.
Testing the Positions and Paths (Continued)

12 Click the Put Plate button.

13 If the instrument you are testing does not have multiple material positions, or if your system does not have more than one storage rack, skip to step 15 on page 88. If the instrument has multiple material positions, the Location Number window (or the Rack Number window, for Storage) opens (see Figure 69).

14 Type the position or rack number you want to test into the text box and click OK. Only a valid position number will be accepted.

15 Observe the robot as it moves through the approach path, to the clearance position for that position, to the material location.

16 If correctly taught, the robot will release the material in the plate location, return to the clearance position, and then move through the clearance path back to the safe position.

If incorrectly taught, reteach the instrument position or path using the appropriate Teach Wizard (see “Teaching the Instrument Positions” on page 64), and return to step 11 on page 87.

17 If the Get Plate and Put Plate functions for this location are successful, repeat this process with the next instrument position or rack location, as appropriate. Return to step 2 on page 86 and repeat until all material locations have been tested and verified.
Twister II Hardware

This section describes the Twister II and Assay Engine Twister II hardware and includes the following sections:

- “Overview” (below)
- “Robot Axes” on page 90
- “Twister II Robot Parts and Functions” on page 92
- “Assay Engine Twister II Parts and Functions” on page 99
- “Rack Parts and Functions” on page 102
- “Communications Cable” on page 103
- “Power Cord” on page 103
- “Optional Components” on page 98

See the *XP Robot User’s Manual* for a description of the XP robot hardware.

Overview

The standard Twister II microplate handler includes the following hardware:

- **Robot** - Canister and tower that contain the mechanisms that direct all motion, including the Robotic Arm.
- **Pod** - Base that holds the racks.
- **Racks (3)** - Racks that hold various types of materials. The top of the materials in the rack can not extend above the top of the rack. Additional pods can be added to the Twister II for a total of up to nine racks.

*Figure 70* shows the parts of the Twister II.

![Twister II diagram](image-url)
Robot Axes

The Twister II robots are cylindrical robots with five separate axes. A home sensor determines the home location for each axis of motion. Figure 71 shows the five axes. A description of each axis follows the figure.

Reach

The Reach axis moves the grip horizontally. The reach axis has a range of 11.25" (28.5 cm.) to 19.75" (50.1 cm.) from the center of the robot post. The total span is 8.5" (21.6 cm.).

The Twister II robot uses the reach movement to place materials at variable distances, which enables the additional capacity of the three-rack pod arrangement and enables the Twister II to access instruments at various distances from the Twister II.

Vertical

The Vertical axis moves the arm up and down. The span is 21.5" (54.6 cm.), from 6.5" (16.5 cm.) to 28" (71.1 cm.) above the table.

The Twister II vertical movement enables you to access instruments at varying heights and to place the instruments on different levels to optimize space.
Rotary

The Rotary axis rotates the arm horizontally around the base of the robot. Mechanical stops prevent continuous rotation. The 340° rotation provides the ability to deliver and retrieve plates to almost any point around the circumference of the Twister II.

The position above each of the rack locations and instruments must be taught after hardware and software installation.

Grip

The Grip consists of two fingers designed to securely grip the sides of the material. The fingers close to grasp the material and open to release the plate.

Wrist

The Wrist mechanism rotates materials to either portrait or landscape position. The range of motion is ±135° (270° total). The wrist feature enables you to access external instruments without requiring that the instrument be exactly perpendicular to the robot.
Twister II Robot Parts and Functions

Twister II Robot Canister

The Twister II robot canister is the base of the robot. The canister is used to rotate the arm and to secure the pod to the robot in a permanent, level position. For more information on the pods, see “Pod Parts and Functions” on page 93. The Assay Engine Twister II’s pod is integrated into the base of the robot (see “Assay Engine Twister II Parts and Functions” on page 99 for details).

The canister has locking positions for three pods.

<table>
<thead>
<tr>
<th>Part</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pod Securing Bracket Hole</td>
<td>Receptacles for the bracket assemblies that secure the pods to the canister.</td>
</tr>
<tr>
<td>Feet (3)</td>
<td>Support and level the robot.</td>
</tr>
<tr>
<td>Positioning Cups</td>
<td>Positions the robot on the table and prevents the robot from accidentally being moved. The robot feet are placed inside the cups after the cups are secured to the table in the correct locations.</td>
</tr>
</tbody>
</table>

Figure 72. Robot Canister
Rack Position Numbers

Rack positions are numbered clockwise, with position 1 closest to the Power Entry Port/Fuse assembly (see Figure 73). The remaining positions are numbered clockwise, continuing through all pod positions and additional pods. If only pods 1 and 3 are installed, the positions in pod 3 are numbered 4, 5, and 6.

Pod Parts and Functions

Pods are platforms attached to the Twister II robot that hold three storage racks. One pod (included with the Twister II) contains the power entry port assembly and provides power to the robot. Additional pods are available. The additional pods do not have power entry ports or electronics. There is a maximum of three storage pods per robot. The Assay Engine Twister II does not have detachable pods, the rack locations are on the base (see page 99).
Exterior Front View

The power switch is a rocker switch located on the outside of the pod that contains the power entry port.

![Figure 74. Power Switch](image)

<table>
<thead>
<tr>
<th>Part</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pod Cover</td>
<td>Covers the top of the pod. Removable to access the screws that attach the pod to the robot base.</td>
</tr>
<tr>
<td>Power On LED</td>
<td>Green indicator light. When lit, indicates the Twister II is powered on.</td>
</tr>
<tr>
<td>Power Switch</td>
<td>Rocker switch labeled 1/0. When the switch is on (1), the LED light turns on. Make sure the Twister II is positioned to allow access to the power switch to easily disconnect or turn off/on the unit.</td>
</tr>
</tbody>
</table>
Exterior Rear View

The pod attaches to the robot base and holds three racks. The pod locks onto the robot base to prevent the racks from moving out of position relative to the robot.

One pod contains the power entry port and the power connections to the robot. Each Twister II robot must have exactly one pod with the power entry port.

![Figure 75. Pod with Power Entry Port](image)

<table>
<thead>
<tr>
<th>Part</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pod Securing Location</td>
<td>Location where the securing assembly locks the pod to the robot base.</td>
</tr>
<tr>
<td>Cable Location</td>
<td>Location of the power supply and communication cables that connect to the robot.</td>
</tr>
<tr>
<td>Power Entry Port/Fuse Assembly</td>
<td>The communication port, power port, and fuse block. See “Twister II Power/Fuse Assembly” on page 98 for details.</td>
</tr>
</tbody>
</table>

NOTE

There is only one power entry port for the Twister II, regardless of the number of pods.
Top View

![Image of rack position with labeled parts]

**Figure 76. Rack Position**

<table>
<thead>
<tr>
<th>Part</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rack Locator Lip</td>
<td>Holds the rack on the pod. The back edge of the rack must be under the lip.</td>
</tr>
<tr>
<td>Rack Holding Pin</td>
<td>A retractable pin that presses against the base of the rack to hold the rack on the pod.</td>
</tr>
<tr>
<td>Rack Locator</td>
<td>Centers the rack and holds the rack on the pod.</td>
</tr>
</tbody>
</table>
**Interior View**

The pod locking mechanisms are located inside the top cover of the pod. The locking mechanisms ensure that the pods are firmly attached to the robot.

<table>
<thead>
<tr>
<th>Part</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pod Locking Cap Screw</td>
<td>Cap screw that locks the pod to the securing bracket assembly on the canister.</td>
</tr>
<tr>
<td>Connector Location</td>
<td>Location of the power and communication cables that connect to the robot canister.</td>
</tr>
<tr>
<td>Pod Set Screws</td>
<td>Set screws to stabilize the pod.</td>
</tr>
</tbody>
</table>
Twister II Power/Fuse Assembly

The Power Entry Port/Fuse assembly is located on the side of one pod. There is always only one power entry port for the Twister II, regardless of the number of pods. Additional pods do not have power connectors.

![Twister II Power/Fuse Assembly](image)

**Figure 78. Power/Fuse Assembly**

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication Port</td>
<td>9-pin communication cable port. The communication cable attaches to a comm port on the computer.</td>
</tr>
<tr>
<td>Power Cable Port</td>
<td>Connector for the power cable.</td>
</tr>
<tr>
<td>Fuse Cover</td>
<td>The fuse housing assembly. The fuse configuration must match the power supply, either 100/120V or 240V. If it does not match, you must change the fuse configuration. See “Changing the Twister II Fuse(s)” on page 105.</td>
</tr>
</tbody>
</table>

**WARNING**

Appliance inlet is disconnecting device. Place device or equipment in a manner so that disconnecting device is accessible all the time.

Optional Components

Additional pods and racks are available from Caliper for use with the Twister II robot. Contact Caliper Sales for more information.
Assay Engine Twister II Parts and Functions

Assay Engine Twister II Top View

The Assay Engine Twister II base contains the components to rotate the robot arm around the center axis, and three rack locations. The Assay Engine Twister II base is designed to enable the robot base to be secured to the side of a Caliper Sciclone ALH 3000 liquid handler.

<table>
<thead>
<tr>
<th>Part</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rack Locations</td>
<td>Three locations for the racks.</td>
</tr>
<tr>
<td>Robot Tower</td>
<td>See “Robot Axes” on page 90 for a description of the five robot axes.</td>
</tr>
<tr>
<td>Adjustable Feet (4)</td>
<td>Support and level the robot.</td>
</tr>
<tr>
<td>Base Cover</td>
<td>Removable to access the bolts that secure the Assay Engine Twister II to the Sciclone ALH 3000.</td>
</tr>
<tr>
<td>Power LED</td>
<td>Green indicator light. When lit, indicates the Assay Engine Twister II is powered on.</td>
</tr>
</tbody>
</table>
Assay Engine Twister II Rack Position Numbers

Rack positions are numbered counter-clockwise, with position 1 closest to the front of the Assay Engine Twister II (see Figure 80).

![Rack Numbers](image)

Assay Engine Twister II Power/Fuse Assembly

The Power Entry Port/Fuse assembly is located on the back of the Assay Engine Twister II as shown in Figure 81.

![Power/Fuse Assembly](image)

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication Port</td>
<td>9-pin communication cable port. The communication cable attaches to a comm port on the computer.</td>
</tr>
<tr>
<td>Component</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Power Cable Port</td>
<td>Connector for the power cable.</td>
</tr>
<tr>
<td></td>
<td><strong>WARNING</strong></td>
</tr>
<tr>
<td></td>
<td><em>Appliance inlet is disconnecting device. Place device or equipment in a manner so that disconnecting device is accessible all the time.</em></td>
</tr>
<tr>
<td>Fuse Cover</td>
<td>The fuse housing assembly. The fuse configuration is the same for either 100/120V or 240V. You do not have to change the fuse configuration. See “Changing the Assay Engine Twister II Fuses” on page 108 if you need to change the fuses.</td>
</tr>
<tr>
<td>Power Switch</td>
<td>Rocker switch labeled 1/0. When the switch is on (1), the LED power light turns on. Make sure the Assay Engine Twister II is positioned to allow access to the power switch to easily disconnect or turn off/on the unit.</td>
</tr>
</tbody>
</table>
Rack Parts and Functions

Racks are removable aluminum frames used as input and output locations for the materials. The standard Twister II includes three racks. Each rack has two side handles and one top handle to facilitate removal and transport.

You teach the rack positions using the Twister II Robot software. The racks are interchangeable, but each rack is marked with the pod position, and you may need to re-teach the rack position if racks are changed.

![Figure 82. Storage Rack]

**NOTES**

Do not drop the racks. If the rack is out of shape, the robot will not properly place the materials.

<table>
<thead>
<tr>
<th>Part</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rack Locator Notch</td>
<td>Locks the racks onto the pod in the proper position.</td>
</tr>
<tr>
<td>Side Handles (2)</td>
<td>Fixed handles for connecting or disconnecting racks from the pod.</td>
</tr>
<tr>
<td>Top Handle</td>
<td>Hinged handle for connecting or disconnecting racks from the pod.</td>
</tr>
</tbody>
</table>
Communications Cable

The communications cable connects to the communications port on the side of the Twister II pod or the back of the Assay Engine Twister II and to a serial communications port on the computer. Only one comm port on the computer is required for the Twister II. Additional comm ports are required for additional instruments to the system.

Power Cord

The power cord plugs into the Power Entry Port on the side of the Twister II pod or the back of the Assay Engine Twister II. Input line power of either 100/120V or 230/240V, 50 to 60 Hz, is required.

WARNING

- Use a standard IEC 320-style power cord appropriate for your country.
- Verify the voltage stated on the power entry port matches the voltage for your country. If the Twister II voltage setting is not correct, change the fuse configuration (see “Changing the Twister II Fuse(s)” on page 105). The fuse configuration for the Assay Engine Twister II does not need to be changed.
- Only plug the power cord into a properly grounded outlet supplying the correct voltage. Insert the three-pronged, grounded plug fully.
Twister II - Maintenance

**WARNING**

- Turn OFF the power and disconnect the power cord before performing any procedure that requires removal of any panel or cover, or disassembly of any interior instrument component.
- Removal of protective covers marked with the High Voltage warning symbol shown above can result in a safety hazard.
- All maintenance procedures in this manual can be safely performed by qualified personnel. Maintenance not covered in this manual should be performed only by a Caliper representative. See “Contact Us” on page 7.

**Cleaning the Twister II**

**WARNING**

Reagents used in processing activities with the Twister II may be corrosive, radioactive, flammable, and/or toxic. Refer to the MSDS (Material Safety Data Sheet) for detailed information.
- Avoid direct contact with spilled liquid.
- Wear protective gloves and safety glasses.
- Dispose of liquid, containers, and tips properly.
- Make sure that the waste container is large enough to hold all of the waste generated.

The outside surfaces of the Twister II should be cleaned periodically. Clean only the exterior of the unit. Never remove any instrument covers to clean the inside of the instrument.
- Use a cloth or sponge dampened with water, alcohol, glass cleaner, or a mild soap solution diluted with water.
- If using glass cleaner or mild soap, wipe with a damp cloth or sponge after cleaning to remove any residue.
- Do not use abrasive cleaners.
- Do not spray cleaner onto the instrument.

Clean the gripper and the racks with alcohol or other residue-free solvent.

Wipe up any spills immediately.

Do not allow water or other fluids to drip inside the robot or pods.
Cleaning the Rack Base

The surface beneath the Twister II racks must be clean at all times. Debris or dust under the racks will mis-align the robot and the racks.

Changing the Twister II Fuse(s)

Twister II Fuses:

- **100/120V operation**: 1 x F3A250V, 0.25 x 1.25” (P/N 36483)
- **240V operation**: 2 x T1.6A250V, 5 x 20mm, (P/N 44232)

**NOTE**

To order fuses, contact Caliper Technical Support (see page 7).

The Twister II can operate at 100/120V~ using a single 3Amp fuse or at 240V~ using two 1.6A fuses. For instructions for the Assay Engine Twister II, see page 108.

**WARNING**

- *Electrical shock hazard. Disconnect the power cord before changing the fuses.*
- *For continued fire protection and correct functioning of the unit, replace fuses only with exact part number to prevent fire.*

To change the Twister II fuses or change the fuse configuration:

1. Verify the Twister II power switch is OFF and the power cord is unplugged.

2. Using a small flat-blade screwdriver, gently pry the cover/fuse block assembly (see Figure 83) away from the power entry port housing.

3. Remove the fuse block/cover assembly from the housing.
Changing the Twister II Fuse(s) (Continued)

4 Remove the single 3Amp fuse or the two 1.6Amp fuses. Figure 84 shows the fuse location for a single 3Amp fuse for 100/120V configuration. Figure 85 shows the fuse locations for two 1.6Amp fuses for 240V configuration.

4

Figure 84. 100/120V Fuse Configuration

Figure 85. 240V Fuse Configuration

5 To convert the Twister II fuse configuration for 240V~ operation:

a Using the small, flat-blade screwdriver, loosen the fuse block screw 2 or 3 turns, but do not remove it.

b Gently lift the fuse block away from the screw and pedestal and then remove as shown in Figure 86.

5

Figure 86. Removing the Fuse Block
Changing the Twister II Fuse(s) (Continued)

c  Remove the 3Amp fuse.

d  Turn the fuse block over and replace with the two fuse locations facing up, as shown in Figure 85.

e  Tighten the screw to secure the fuse block to the cover.

f  Place the two 1.6Amp fuses for 240V configuration into the fuse block as shown in Figure 85.

6  Replace the fuses with the same part number fuses.

7  Confirm that the fuses are seated securely in the fuse block.

8  Snap the fuse block/cover assembly back into the housing. See Figure 83 on page 105.
Changing the Assay Engine Twister II Fuses

Assay Engine Twister II Fuses:
• 100 - 240V~ operation: 2 x T2.5A250V, 5 x 20mm (P/N 114703)

NOTE

To order replacement fuses, please contact Caliper Technical Support. See “Contact Us” on page 7.

The Assay Engine Twister II operates at 100 - 240V~ using two 2.5A fuses. For instructions for the Twister II, see “Changing the Twister II Fuse(s)” on page 105.

WARNING

• Electrical shock hazard. Disconnect the power cord before changing the fuses.
• For continued fire protection and correct functioning of the unit, replace fuses only with exact part number to prevent fire.

To change the Assay Engine Twister II fuses:

1 Verify the Assay Engine Twister II power switch is OFF and the power cord is unplugged.

2 Using a small flat-blade screwdriver at the top of the fuse housing, gently pry the fuse housing (see Figure 87) out of the power entry port.

Figure 87. Assay Engine Twister II Power Entry Port
Changing the Assay Engine Twister II Fuses (Continued)

3 Remove the two 2.5Amp fuses. Figure 88 shows the fuse housing for the Assay Engine Twister II.

![Figure 88. Assay Engine Twister II Fuses](image)

4 Replace both fuses with the same part number fuses.
5 Confirm that the fuses are seated securely in the fuse housing.
6 Snap the fuse housing back into the power entry port.

Moving the Twister II

If you need to relocate the Twister II:

1 Remove all racks from the pods and materials from the racks.
2 Turn OFF the power.
3 Unplug the power cord from the power outlet and from the receptacle on the side of the pod.
4 Disconnect the communications cable from the side of the pod.
5 Prepare a space to accommodate the Twister II during the move (an empty area on the lab bench or a sturdy cart).
6 Disconnect all the pods from the robot canister. Reverse the hardware installation steps in the Robot Installation Instructions.

**WARNING**

*The Twister II weighs approximately 50 pounds (22.7 kg) and should be lifted by at least two people. Take the proper precautions to avoid injury.*
Moving the Twister II (Continued)

7 Lift the Twister II straight up and off the bench/table and set it carefully on the new bench or cart. Depending on the distance that you are moving the instrument, you may wish to repackage the Twister II in its original shipping carton.

8 To re-install the Twister II, follow the instructions described in the Robot Installation Instructions.

Long-Term Shutdown

If the Twister II will not be used for an extended period of time, clean the external surfaces of the instrument, unplug the power cord, and cover the Twister II and racks with a plastic or cloth cover.
## Troubleshooting

This section describes problems you may have with the Twister II robot and provides a solution to the problem. This section also includes performance checks to verify that the robot is operating properly. Routine maintenance procedures are provided in “Twister II - Maintenance” on page 104. For problems with the Twister II that are not listed here, contact Caliper Technical Support (see “Contact Us” on page 7).

### Twister II Troubleshooting

#### Issue 1   The Twister II does not turn on properly when switched on, or does not initialize.

<table>
<thead>
<tr>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power cord not firmly attached</td>
<td>Verify power cord is securely seated in receptacle.</td>
</tr>
<tr>
<td>Blown fuse</td>
<td>See “Changing the Twister II Fuse(s)” on page 105.</td>
</tr>
<tr>
<td>Fuse configuration not correct</td>
<td>See “Changing the Twister II Fuse(s)” on page 105.</td>
</tr>
<tr>
<td>Communication cable not firmly</td>
<td>Verify communication cable is inserted properly and seated securely in</td>
</tr>
<tr>
<td>attached</td>
<td>receptacle.</td>
</tr>
</tbody>
</table>

#### Issue 2   The Twister II arm crashes.

<table>
<thead>
<tr>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Twister II lost the proper orientation due to</td>
<td>Disable the servo motors using the Twister II Robot software. Manually move the robot to the proper position. Re-enable the servo motors.</td>
</tr>
<tr>
<td>contact with an object in the arm’s path</td>
<td>Run a check on the robot positions.</td>
</tr>
<tr>
<td>Robot positions not correct</td>
<td>In the Twister II Robot software, re-teach the instrument or storage positions.</td>
</tr>
<tr>
<td>Plates were added or removed during the run</td>
<td>Do not add or remove plates from the input or output racks during operation.</td>
</tr>
</tbody>
</table>

#### Issue 3   The Twister II does not properly place materials into an instrument or the storage racks.

<table>
<thead>
<tr>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The position was not taught correctly</td>
<td>Re-teach the position (see page 113).</td>
</tr>
</tbody>
</table>
## Issue 3  The Twister II does not properly place materials into an instrument or the storage racks.

<table>
<thead>
<tr>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The instrument was moved</td>
<td>Re-teach the instrument positions (see page 113).</td>
</tr>
<tr>
<td>The wrong rack is in a rack position (e.g. Rack 3 is in rack position 2)</td>
<td>Either place the proper rack in the position or re-teach the storage positions (see page 113).</td>
</tr>
<tr>
<td>The plates are rubbing on the input or output racks.</td>
<td>Re-teach the storage positions (see page 113).</td>
</tr>
<tr>
<td>The Twister II is not lowering the plates all the way down before releasing them.</td>
<td>Re-teach the storage positions (see page 113). Make sure the storage configuration is correct if using the Stack Storage resource for CLARA.</td>
</tr>
</tbody>
</table>
Re-Teaching the Storage Positions

If you have added additional pods or racks to the Twister II or if the racks have been moved slightly and are not properly aligned with the robot, you should re-teach the storage positions. You can teach the storage positions with the Robot software in either Standalone mode (started from the Windows Start menu) or in Remote mode (started and initialized by Caliper automation control software).

To re-teach the storage positions, follow the instructions in “Teaching the Twister II Storage Racks” on page 56. After you type the name in the Instrument Name window, you are prompted to save the existing VBA. Click the Yes button. If you do not have custom VBA code in the rack module and want to start with clean VBA code, you can click the No button to over-write the rack’s VBA code.

Re-Teaching the Instrument Positions

If you have added material positions to an instrument or if an instrument has been moved slightly and is not properly aligned with the robot, you should re-teach the instrument position. You can teach the instrument positions with the Robot software in either Standalone mode (started from the Windows Start menu) or in Remote mode (started and initialized by Caliper automation control software).

NOTE

If you move an instrument in the system, you must re-teach all of the material positions for that instrument.

To re-teach an instrument position, follow the instructions on “Teaching the Instrument Positions” on page 64. After you type the name in the Instrument Name window, you are prompted to save the existing VBA. Click the Yes button. If you do not have custom VBA code in the instrument module and want to start with clean VBA code, you can click the No button to over-write the instrument’s VBA code.
Adjusting the Instrument Positions

If the robot does not put the materials in the correct position in an instrument, the instrument or robot may have been moved slightly out of position. This can sometimes be corrected by moving the instrument back into position as described below.

1. Place ONE material in the instrument. If adjusting an instrument with a drawer that opens and closes, ensure that the drawer is fully open.

2. Open the robot software in standalone mode. Use the existing positions to move the robot to the instrument position.

3. Move the instrument slightly to enable the robot to properly place the material in the position.

If repositioning the instrument does not solve the problem, you should re-teach the instrument position, as described on page 113.

For problems with rack positions, you should re-teach the rack positions, as described on page 113.

If you continue to have problems, contact Caliper Technical Support (see “Contact Us” on page 7).
Twister II Performance Checks

Use the procedures in this section to verify whether there are problems with the Twister II. If all axes move correctly, but you have problems moving to a specific taught position, you may need to re-teach the position or path. See “Re-Teaching the Storage Positions” on page 113 or “Re-Teaching the Instrument Positions” on page 113.

To verify proper operation of the Twister II:

1. In the Robot software, click the Manual Controls tab.

   ![Figure 89. Manual Controls Tab](image)

2. Click the Initialize button to initialize the robot and establish communication.

3. Click the Home All Axes button to move all axes to the home positions.

4. Use the Jog positioning arrows or slide bar to move each axis and verify the axis moves properly.

5. If the axis does not move correctly, type the numeric value of the position in the Target Position text box, and try the move again.

6. If the arm still does not move correctly, try incrementing the position using the up and down arrows on the Target Position text box.

7. If the arm does not move correctly on all axes, contact Caliper Technical Support (see “Contact Us” on page 7).
Power Loss During Operation

If you routinely operate the system overnight or with valuable samples, Caliper recommends using a 900-watt (or greater) uninterruptable power supply (UPS) to provide a back-up power source for the robot, the external instrument(s), and the computer.

If the Twister II robot is turned off or loses power during operation, the robot grip loses tension and the arm may drop. Make sure to hold the arm before disconnecting the power.

WARNING

The Twister II arm may drop and the grips may open when the Twister II loses power, which may result in spilled liquids if the robot is holding a filled plate. You should remove any materials from the grip and hold the Twister II arm if you turn off the power while the Twister II is holding a plate.
Appendix A: Software Reference

This section provides detailed descriptions of each of the windows in the Robot software (see below), the Robot Teach Wizards (see page 139), and the Stack Storage software (see page 158).

For operating instructions, see page 23. For installation instructions, see the Robot Install Instructions on the installation CD.

Robot Software

The Robot Integration Kit includes the Robot software (ICP) and the Robot IA (Interface Adapter). This section describes each of the windows in the Robot software in detail. The Robot IA does not have a user interface and runs in the background.

The Robot software is used to operate the robot manually, to provide a server for the automation client, and to create or edit robot positions. The positions stored in the Robot software are used by the automation control software to move the robot to the proper positions.

Robot Software Main Window

The Robot software main window (see Figure 90) is used to operate the robot, create positions, and view the status of robot operation. The title bar displays the name of the currently open project.

![Figure 90. Robot Software Main Window](image-url)
Menu Bar

The Robot software Menu Bar contains the following menus:

File Menu

New - Opens a new project (.ini) file.
  • If you made any changes to the currently open project, the software prompts you to save the changes (see Figure 91). After you click Yes or No, an untitled project (based on the TwisterII template) opens.

![Figure 91. Save Changes Window](image)

Open - Opens the Open Project window (see page 130) to open an existing project.

Save - Saves the currently open project (.ini) file, and the associated .xpd, and .pos files. If the project is a new untitled project, the Save As window (see page 130) opens.

Save As - Opens the Save As window (see page 130) to save a project with a new name.

Exit - Closes the Robot software.

View Menu

Log - Opens the Log window (see page 135) to view a log of the commands and moves.

Configuration Menu

Settings - Opens the Settings window (see page 136) to set the COMM port and the Simulation mode.

Tools Menu

Visual Basic Editor - Opens the Visual Basic Editor window (see page 137).

Macros - Opens the Visual Basic Application Macro editor (see page 138).
Help Menu

**About** - Opens the About window (see page 139) to view software version, copyright, and contact information.

**Button Bar**

**New Button** - Opens a new, untitled, project. See "File Menu" on page 118 for details.

**Open Button** - Opens the Open Project window (see page 130) to open an existing project.

**Save Button** - Saves the project (.ini) file and the associated .xpd and .pos files. If the file has not been saved yet, opens the Save As window (see page 130) to save the project.

**Log Button** - Opens the Log window (see page 135) to view a log of the commands and moves.

**Find Material Button** - Causes the robot arm to slowly lower until the grip contacts a surface; The arm moves directly down from its current position. No other axes move. The arm must be properly positioned over the material before clicking the Find Material button.

**WARNING**

*Failure to position the robot arm properly over the material may result in a crash. Verify the arm position before clicking the Find Material button.*

**Grip Material Button** - Closes the grips.

**Grip Open Button** - Opens the grips.

**WARNING**

*The robot must be in an appropriate location to place a material before opening the grips to avoid dropping the plate.*

**More Tools Button** - Opens the Add or Remove Buttons menu to customize the button bar.
Status Bar

The **Status** bar displays the current status of the robot.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simulation Mode</td>
<td>Displays the simulation mode for the open robot project. Displays <strong>Simulation Mode</strong> if simulation is on, or the COM port number if simulation is off.</td>
</tr>
</tbody>
</table>
| Operation Status       | Current status of the robot:  
  - Idle - Not in operation, no errors.  
  - Homed - The robot is at the Home position.  
  - Busy - Waiting for hardware response, command pending.  
  - Aborted - The last robot command was stopped.  
  - Error - A hardware error occurred while executing the last command. |
| Software Control Status| The current Software Control Status, either Standalone or Remote (see page 22 for more information). |
| Software Name and Revision | Software name and revision number. |

Figure 92. Status Bar
Manual Controls Tab

The **Manual Controls** tab (see Figure 93) is used to move the robot manually. For details on using this tab, see “Moving the Robot Manually” on page 50.

![Manual Controls Tab](image)

**Figure 93. Manual Control Tab**

The following buttons and options are available on the Manual Control tab:

- **Initialize Button** - Establishes communication with the robot. The robot must be initialized after the robot power is turned on or the Robot software is started.

- **Home All Axes Button** - Moves the robot to the home position of each axis, in the order shown below. You must Home the robot after initialization and before manual operation or a move operation.

**WARNING**

*Home All Axes* moves the robot from its current position to home in the order shown below. Make sure there are no obstructions prior to executing the command to prevent a robot crash or spilling of material contents.

1. Vertical - Arm lifts to highest position.
2. Reach - Arm moves in toward robot tower.
3. Rotary - Robot rotates to a position above rack 2.
4 **Wrist** -
   - **Twister II:** The wrist rotates the grips to a position perpendicular to the robot arm.
   - **XP Robot:** The wrist rotates the grips to a position parallel to the work surface.

5 **Grip** - Grips open.

6 **Track** - If the robot is mounted on a track, the robot moves to the beginning of the track.

**Enable All Servos Button** - Engages the motors for each axis. When an axis motor is engaged, the motor holds the axis in its current position and you use the Robot software to move the axis.

**Disable Servos for Teaching Button** - Disengages the motors for all axes except the grip (this prevents the robot from dropping a material if there is a material in the grips). You must disable servos to move the robot manually.

**WARNING**

![Warning symbol]

*The robot arm will drop when the servos are disabled. Hold the robot arm before issuing this command to prevent a possible crash or spilling of material contents.*

**Abort Move Button** - Immediately stops the current move and clears an error status if an error has occurred. If automation control software started the move, an alarm is generated in that software.

**Servo Enabled Check Box** - If selected, the motor for the axis is engaged. If cleared, the motor for the axis is disengaged.

**Get Current Position Button** - Click to display the robot’s current axis position on the button.

**Target Position Text Box** - Specifies the position on the axis to move the robot. Type the desired position in the text box and press the Enter key to move the robot.

The up and down arrows increment the number and move the robot to the specified position. Pressing Shift, Control, or Alt keys increment the setting by larger values. Displays the current position if the axis motor is enabled.
Jog Buttons and Slider

Use these controls to move an axis to a specified position. The arrow buttons move the axes by small increments. You can set the Jog Increment by right clicking on either arrow and entering the desired number in the Set Jog Increment window, shown in Figure 94.

![Figure 94. Set Jog Increment Window](image)

The Jog slider controls enable you to quickly move to a position. The robot moves when you release the slider.

Speed

Sets the speed with which each axis’s servo motor moves when operating the robot manually. This setting does not affect the move speed when operating the robot in remote mode.

Teach Tab

The Teach tab (see Figure 95) provides automated tools for teaching the robot the positions of the instruments in the system and the Paths to and from the instruments in the system. For more information on Paths and Positions, see “Robot Software Terminology” on page 17. For information on using the Teaching Wizards, see “Teaching the Robot” on page 56.

![Figure 95. Teach Tab](image)
**Names Tab** - Displays the names of the instruments in the system. Select a name to display the positions (on the Positions tab) and the paths (on the Paths tab) that have been taught for the instrument.

The Robot instrument does not have any associated paths or positions unless you have upgraded the Robot software from a version prior to V2.1.

**Add Button** - Used to add a new instrument to the system and teach the positions for the instrument.

- If Caliper automation control software, such as CLARA, is installed, the Add Instrument from CLARA or iLink window opens (see page 131).
- If Caliper automation control software is not installed, the Instrument Name window opens (see page 132).

**Remove Button** - Deletes the instrument selected in the **Names** tab. The positions and paths for that instrument are also deleted.

**Teach Tab - Positions Tab**

Use the **Positions tab** (see Figure 96) to view, edit, create, or delete instrument positions.

![Figure 96. Positions Tab](image)

**Positions List** - Displays the positions that have been taught for the instrument selected in the **Names** tab. The positions are listed in alphabetical order. Instrument positions created by the Teach Wizard consist of Pick, Place, Clearance and Safe positions, but do not include path positions. For information on positions and paths, see "Robot Software Terminology" on page 17. For information on teaching positions, see page 56.
Teach Tab - Positions Tab (Continued)

The table below describes the data in the Positions list.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The position name. Positions are named by the user if they are created manually, or by the software if created by the Teach Wizard.</td>
</tr>
<tr>
<td>Type</td>
<td>The position type, either Absolute or Relative. For information on position types, see page 19.</td>
</tr>
<tr>
<td>Vertical</td>
<td>The numeric position of the robot vertical axis.</td>
</tr>
<tr>
<td>Reach</td>
<td>The numeric position of the robot reach axis.</td>
</tr>
<tr>
<td>Rotary</td>
<td>The numeric position of the robot rotary axis.</td>
</tr>
<tr>
<td>Wrist</td>
<td>The numeric position of the robot wrist axis.</td>
</tr>
</tbody>
</table>

**New Button** - Opens the Add Position window (see page 133) to create a new position for the selected instrument.

**Delete Button** - Deletes the position selected in the Positions list.

**Move To Button** - Moves the robot directly to the position highlighted in the Positions list.

**WARNING**

*The Move To button moves the robot from its current position directly to the position selected in the Positions window in one direct motion. Make sure there is a clear path to the position before clicking the Move To button to prevent a robot crash or spilling of material contents.*
Teach Tab - Paths Tab

Use the **Paths tab** (see Figure 97) to create or delete Paths for the instrument selected in the **Names** tab.

![Figure 97. Paths Tab](image)

**Paths Drop-Down List** - Displays the paths for the instrument selected in the **Names** tab. The positions in the selected path are displayed in the Positions list. The Teach Wizard creates Approach and Clear paths, which do not include instrument positions. For more information on paths and positions, see “Robot Software Terminology” on page 17.

**New Path Button** - Opens the New Path window (see page 133).

**Delete Path Button** - Deletes the path selected in the **Paths** list.

**Execute Path Button** - Executes the path selected in the **Paths** list. The robot moves to the positions in numeric order.

**WARNING**

*The Execute button moves the robot from its current position directly to the first position in the Path Position list in one direct motion. Make sure there is a clear path to the first position before clicking the Execute button to prevent a robot crash or spilling of material contents.*

**Path Positions List** - Displays the positions in the path selected in the **Paths** drop-down list. The Teach Wizard creates an Approach path and Clear path for an instrument if you teach Clear positions when the wizard asks if the arm is clear to move all the way up vertically.
Teach Tab - Paths Tab (Continued)

The table below describes the data in the Path Positions list.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The position name. The positions are executed in numeric order. Path positions are named automatically by the software.</td>
</tr>
<tr>
<td>Type</td>
<td>The position type, either Absolute or Relative. For information on Absolute or Relative positions, see page 19.</td>
</tr>
<tr>
<td>Vertical</td>
<td>The numeric position of the robot vertical axis.</td>
</tr>
<tr>
<td>Reach</td>
<td>The numeric position of the robot reach axis.</td>
</tr>
<tr>
<td>Rotary</td>
<td>The numeric position of the robot rotary axis.</td>
</tr>
<tr>
<td>Wrist</td>
<td>The numeric position of the robot wrist axis.</td>
</tr>
</tbody>
</table>

**New Position Button** - Creates a new position and adds it to the path selected in the Paths list. The new position is created from the current position of the robot. Move the robot to the desired position before you click the New Position button. The new position is added to the end of the list of positions and is executed as the last move in the path.

**Delete Position Button** - Deletes the position selected in the Path Positions list. Positions must be deleted sequentially, from the last position in the path to the first.

**NOTE**

*If you add or delete positions in the Approach path, you must also add or delete the same positions in the Clear path. The Clear path executes the positions in reverse numerical order.*
Teach Tab - Test and Verify Tab

The **Test and Verify** tab is used to test the positions and paths leading to and from the instrument selected in the **Names** tab.

![Figure 98. Test and Verify Tab](image)

**Get Plate Button** - Uses the instrument’s Approach path, Pick positions, and Clear path to remove a material from the instrument selected in the Names tab. If the instrument has more than one material position, the Plate Location window (see page 134) opens to specify the position where you want to get the plate.

**Put Plate Button** - Uses the instrument’s Approach path, Place positions, and Clear path to place a material into the instrument selected in the Names tab. If the instrument has more than one material position, the Plate Location window (see page 134) opens to specify the position where you want to place the plate.
Diagnostics Tab

The Diagnostics tab (see Figure 99) displays the status of the robot axes. This information is generally used by Caliper Support personnel.

![Diagnostics Tab](image)

**Figure 99. Diagnostics Tab**

**Axis Buttons** - Click an axis button to display the current status of the robot axis.

When you click an axis button, the Status, Firmware, and Status Description text boxes display the status for that axis as described below:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Long Raw Data</td>
<td>A numeric representation of the text displayed in the Status Description window</td>
</tr>
<tr>
<td>Hex Raw Data</td>
<td>A numeric representation of the text displayed in the Status Description window</td>
</tr>
<tr>
<td>Firmware Version</td>
<td>Displays the current firmware version of the Twister II Robot.</td>
</tr>
<tr>
<td>Status Description</td>
<td>Provides the status detail for the selected axis, such as: flag data, command completed status.</td>
</tr>
<tr>
<td>Clear Hardware Errors</td>
<td>This button aborts a robot error, clears the robot of the error state.</td>
</tr>
<tr>
<td>Update Status</td>
<td>Refreshes the data for the selected axis.</td>
</tr>
</tbody>
</table>
Open Window

Use the Open window (see Figure 100) to open an existing robot INI file. All robot INI files must be located in the \ZyRobot\ICP folder.

![Figure 100. Open Window](image)

Select the INI file to open and click the OK button to open the robot project. Click the Cancel button to close the window without opening an INI file.

Save As Window

Use the Save As window (see page 130) to save the currently open project (.ini) file and the associated .xpd and .pos files with a new name. If you are saving a new, untitled project, the Save As window opens when you click the Save button.

![Figure 101. Save As Window](image)

Select an .ini file name or type a new file name in the File Name text box, and click the Save button.
Add Instrument from CLARA or iLink Window

The Add Instrument from CLARA or iLink window opens if you have Caliper automation control software installed on the same computer as the Robot software and you click the Add button on the Teach Tab.

![Add Instrument from CLARA or iLink window](image)

**Figure 102. Add Instrument from CLARA or iLink window**

Click the **Yes** button if you want to add and teach an instrument that has already been defined in the automation control software. (Using this option ensures that the instrument name in the robot software exactly matches the resource name in the automation control software.) The Instruments window opens (see page 132).

Click the **No** button if you want to type in the name of the instrument. You can use this option to teach an instrument before the resource has been added to the automation control software, but you must make sure that the resource name in the automation control software exactly matches the instrument name in the Robot software. The Instrument Name window opens (see page 132).
## Instruments Window

The **Instruments** window (see Figure 103) displays the names of all of the resources in the Caliper automation control software. If the instrument that you want to teach is not listed in the Instruments window, you must create the resource in the automation control software. For information on creating resources in the automation control software, see the CLARA or iLink PRO User’s Manual.

![Instruments Window](image)

**Figure 103. Instruments Window**

Select an instrument name and click the OK button to add the instrument name to the Names tab in the Robot software and start the Teach Wizard.

Click the Cancel button to close the Instruments window without adding the instrument name or starting the Teach Wizard.

## Instrument Name Window

Use the Instrument Name window to create and teach a new instrument. If you type the same name as an instrument that already exists, you are prompted to keep the existing VBA or overwrite with the default.

![Instrument Name Window](image)

**Figure 104. Instrument Name Window**

Type the desired instrument name in the text box. Clicking the OK button starts the Teach Wizard (see page 139) to teach the positions.
Add Position Window

Use the Add Position window to add a new position to the instrument selected in the Names tab. The new position is created from the current position of the robot. Move the robot to the desired position before you click the New button. To open the Add Position window, click the New button on the Positions tab on the Teach tab.

![Add Position Window](image)

**Figure 105. Add Position Window**

- **Name** - The name of the new position.
- **Type** - The position type, either Absolute or Relative. For more information, see page 19.
- **OK** - Saves the new position with the specified name and closes the Add Position window.
- **Cancel** - Closes the window without creating a new position.

New Path Window

Use the New Path window to create a new path for the instrument selected in the Names tab. The path does not include any positions when it is created. Use the New Position button on the Paths tab (see page 126) to create the positions.

![New Path Window](image)

**Figure 106. New Path Window**

- **Path Name text box** - The name of the path to create.
- **OK** - Creates the new path and adds it to the Paths list.
- **Cancel** - Closes the New Path window without creating a new path.
Plate Location Window

Use the **Plate Location** window to specify which instrument position you want the robot to get a plate from or put a plate into. To open the Plate Location window, click the Get Plate or Put Plate button on the Test and Verify tab (see page 128).

![Figure 107. Plate Location Window](image)

**Plate Location** - The Instrument position number that you want the robot to get a plate from or put a plate into. Only specify position numbers that have already been taught.

**OK** - Moves the robot through all required positions and paths to retrieve a material from or place a material into the selected material position.

**WARNING**

*The robot moves from its current position **directly** to the selected instrument’s Safe position in one direct motion. Make sure there is a clear path to the instrument’s Safe position before clicking OK to prevent a robot crash or spilling of material contents.*

**Cancel** - Closes the Plate Location window without moving the robot.
Log Window

The Log window displays a record of all recent commands received and actions performed. To open the Log window, click the Log button on the Robot main window.

![Log Window](image)

**Figure 108. Log Window**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processes/Exceptions</td>
<td>Displays the actions performed through the Robot software’s automation interface and the details of each action.</td>
</tr>
<tr>
<td>Serial Communication</td>
<td>Displays the messages sent to and received by the robot hardware controller.</td>
</tr>
<tr>
<td>Clear This Log</td>
<td>Erases the data from the selected communication type, only.</td>
</tr>
<tr>
<td>Clear All Logs</td>
<td>Erases the data from both communication types.</td>
</tr>
<tr>
<td>Save to File</td>
<td>Saves the data from the selected communication type to a .txt file in the ICP folder.</td>
</tr>
<tr>
<td>Done</td>
<td>Closes the Log window.</td>
</tr>
</tbody>
</table>
Settings Window

Use the Settings window (see Figure 109) to specify the simulation setting and the Comm port. To open the Settings window, select File→Settings on the Robot software main window.

The settings option opens the Settings window.

![Figure 109. Settings Window](image)

**Simulation Mode** - If On, communication with the robot is simulated and the robot does not move. If Off, enables communication with the robot using the specified Comm port.

**Comm Port** - The number of the Comm port that the robot is connected to on the computer.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apply</td>
<td>Applies the specified settings and closes the Settings window. To save the settings in the INI file, select File→Save on the Robot software main window.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Closes the Settings window without changing the settings.</td>
</tr>
</tbody>
</table>
Visual Basic Editor Window

VBA is used to create the macros and programs that can be used in the automation control software (or other integrated system) to operate the robot. For more information on VBA programming, please see the *Robot Software Programmer’s Manual*.

![Visual Basic Editor Window](image)

**Figure 110. Visual Basic for Applications Main Screen**

**NOTE**

*This editor should only be used by VBA trained staff.*

When debugging VBA macros in standalone mode, you may not see error messages displayed. The Log window or the VBA debugging tools should be used to display needed information.
VBA Macros Window

Use the Visual Basic for Applications (VBA) Macros Window (see Figure 111) to select a robot macro for editing. VBA macros define the robot movements used in an integrated system. For more information on programming macros, please see the Robot Software Programmer’s Manual. To open the VBA Macros window, select Tools→Macros on the Robot Software main window.

![VBA Macro Window](image)

**Figure 111. VBA Macro Window**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Macro Name</strong></td>
<td>Displays the highlighted Macro and all the Macros in the selected dictionary file.</td>
</tr>
<tr>
<td><strong>Macros In</strong></td>
<td>Displays the selected dictionary file name.</td>
</tr>
<tr>
<td></td>
<td>Provides a drop-down list to choose a different dictionary (.xpd) file.</td>
</tr>
<tr>
<td><strong>Description</strong></td>
<td>Text box to add or display a Macro description.</td>
</tr>
<tr>
<td><strong>Run</strong></td>
<td>Performs the highlighted macro.</td>
</tr>
<tr>
<td><strong>Cancel</strong></td>
<td>Closes the macro window.</td>
</tr>
<tr>
<td><strong>Step Into</strong></td>
<td>Opens the VBA program in debug mode.</td>
</tr>
<tr>
<td><strong>Edit</strong></td>
<td>Opens the VBA program in edit mode to edit the selected Macro.</td>
</tr>
<tr>
<td><strong>Create</strong></td>
<td>Creates a new Macro with the name in the Macro Name text box in the selected dictionary file.</td>
</tr>
<tr>
<td></td>
<td>Opens the VBA program for writing the new Macro code.</td>
</tr>
<tr>
<td><strong>Delete</strong></td>
<td>Deletes the selected macro.</td>
</tr>
</tbody>
</table>
About Window

The **About** window displays the current software version and a link to the Caliper website.

![About Window](image)

**Figure 112. About Window**

Teach Wizard

This section describes the windows used to teach the racks and instruments. The Teach wizards automate the process of teaching instrument positions in the Caliper Life Sciences Robot software. The wizards enable you to teach either the Twister II racks or an instrument. See "Teaching the Robot" on page 56.

The Teaching Wizards can be used to reteach the instrument or rack positions. For more information, see “Re-Teaching the Storage Positions” on page 113 or “Re-Teaching the Instrument Positions” on page 113.

When you click the Add button on the Teach tab to add a new instrument or rack, if Caliper automation control software such as CLARA or iLink is installed on the computer, the “Add Instrument from CLARA or iLink Window” displays. If you click the **Yes** button, you can choose a resource from the automation control software. This ensures that the name of the resource matches the taught positions, which is required for the robot to function properly. For more information on resource names, see “Teach Tab” on page 123.

After you choose or type the instrument or rack name, the “Select Teaching Wizard Window” asks if you are teaching the Twister II racks. If you click Yes, the Rack Teach Wizard starts (see page 142). If you select No, the Instrument Teach Wizard starts (see page 147). You must use the correct wizard when teaching instruments or racks.
Teach Wizard Buttons

The Teach Wizard windows have the same buttons at the bottom of the window that perform the functions described below.

![Teach Wizard Buttons](image)

**Figure 113. Teach Wizard Buttons**

<table>
<thead>
<tr>
<th>Option</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Abort</td>
<td>Aborts the act of teaching a position.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Closes the Rack Teach Wizard without saving the positions that were taught.</td>
</tr>
<tr>
<td>Back</td>
<td>Returns to the previous window.</td>
</tr>
<tr>
<td>Next</td>
<td>Advances to the next window.</td>
</tr>
<tr>
<td>Finish</td>
<td>Completes position teaching and closes the wizard.</td>
</tr>
</tbody>
</table>
Select Teaching Wizard Window

Use the Select Teaching Wizard to choose whether to teach an instrument or the Twister II racks. It is very important to use the correct teaching wizard, since the wizards create different types of positions based on this selection.

Choose **Yes** to start the Rack Teach Wizard. See “Rack Teach Wizard” on page 142

Choose **No** to start the Instrument Teach Wizard. See “Instrument Teach Wizard” on page 147 for descriptions of each window in the Instrument Teach Wizard.
Rack Teach Wizard

Use the Rack Teach Wizard to teach the Twister II storage racks. This section describes each window in the Rack Teach Wizard.

Rack Teach Wizard - Welcome Window

The Welcome window welcomes you to the wizard and describes the requirements for starting to teach.

![Figure 114. Rack Teach Wizard, Welcome Window]

Rack Teach Wizard - Set Speed Window

Use the Set Speed window to set the speed at which the robot moves into and out of the racks. Default is 50%.

![Figure 115. Rack Teach Wizard, Set Speed Window]
Rack Teach Wizard - Select Racks Window

Use the Select Racks window to specify the number of racks in the system. You can use this window to re-teach specific racks by selecting only the racks that you want to re-teach. Rack 1 is always selected and re-taught when you run the Rack Teach Wizard.

![Select Racks Window]

**Figure 116. Rack Teach Wizard, Select Racks Window**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Racks to Teach</td>
<td>Select the check boxes for the racks that you want to teach. You must teach the rack before you can use the automation control software to move plates into or out of the rack. Rack 1 is always taught.</td>
</tr>
</tbody>
</table>
Rack Teach Wizard - Place Teach Block Window

The Place Teach Block window describes where to place the teach block and prepares to disable the motors for teaching. Hold the arm before clicking the Next button.

![Figure 117. Rack Teach Wizard, Place Teach Block Window](image)

**WARNING**

*Clicking Next causes the robot arm to drop. Be sure to hold the robot arm before clicking Next to prevent the arm from dropping.*

Rack Teach Wizard - Teach Rack 1 Window

The Teach Rack 1 window shows how to set up the robot and plate for teaching the first rack.

![Figure 118. Rack Teach Wizard, Teach Rack 1 Window](image)

Clicking **Next** creates the Rack 1 position on the Positions tab.
Rack Teach Wizard - Teach Rack 2 Window

The Teach Rack 2 window shows how to position the robot to teach Rack 2. A Teach Rack window is displayed for each rack in the system. When you click the Next button on each window, the position for the specified rack is created and added to the Positions tab.

Figure 119. Rack Teach Wizard, Teach Rack 2 Window

NOTE

You must lift the robot arm from underneath the arm and move the arm and teach plate to the next rack. **If the robot drops the teach plate, you must re-teach all racks.**

Click **Next** to teach any remaining racks. When all racks are taught, the Finish window opens.
Rack Teach Wizard - Finish Window

When you finish teaching the selected racks, the Finish window opens.

![Figure 120. Rack Teach Wizard, Finish Window](image)

Clicking Finish closes the Rack Teach Wizard. The Robot software opens the Save Changes window to prompt you to save your changes.

- If you choose Yes, the changes are saved, the teach wizard closes, and the new positions are displayed in the Robot software.
- If you choose No, the changes are displayed in the software but are not saved. To keep the changes, select File→Save or File→Save As on the Robot main window. To discard the changes, close the Robot software and choose No When prompted to save the changes.

![Figure 121. Save Changes Window](image)
Instrument Teach Wizard

Use the Instrument Teach Wizard to teach the instrument positions in the system. Each instrument can be taught multiple material positions. The Instrument Teach Wizard opens when you specify that you are not teaching the racks.

![Figure 122. Instrument Teach Wizard](image)

This wizard teaches the positions of instruments with multiple material positions and instruments that require different positions for Pick and Place.

Instrument Teach Wizard - Welcome Window

The Welcome Window welcomes you to the wizard and describes the requirements for teaching.

![Figure 123. Instrument Teach Wizard, Welcome Window](image)
Instrument Teach Wizard - Set Speed Window

Use the Set Speed window to set the speed at which the robot moves into and out of the instrument. Default is 50%.

![Figure 124. Instrument Teach Wizard, Set Speed Window](image)

Instrument Teach Wizard - Plate Delivery Mode Window

Use the Plate Delivery Mode window to choose how the robot moves into the instrument to retrieve a plate. The Find Plate option moves the arm down until the plate sensor in the arm detects that the instrument has contacted the material (or the material has contacted the instrument position. The Move to Absolute Position option moves the plate to the taught location and does not check the plate sensor to verify the plate was contacted. The default is Find Plate.

![Figure 125. Instrument Teach Wizard, Set Speed Window](image)
**Instrument Teach Wizard - Number of Locations Window**

Use the Number of Locations window to specify the number of material locations in the instrument. Specify only the number of material locations where the robot can access materials. For example: The Sciclone has 20 material locations, but if the robot can only access 5 positions, select 5 as the number of material locations. If you are re-teaching locations, you must re-teach all of the material locations for the instrument.

![Figure 126. Instrument Teach Wizard, Number of Locations Window](image)

Figure 126. Instrument Teach Wizard, Number of Locations Window
Instrument Teach Wizard - Position Number Window

Use the Position Number window to specify the position number that you want to teach. The position number can be different from the location number. For example, if you are teaching the Sciclone, you may want location 1 to be taught as position 4, location 2 = position 5, location 3 = position 9, location 4 = position 10, and location 5 = position 20 (depending on which Sciclone positions the robot can access). Then in the automation control software, you would set up a Move to Sciclone position 5.

![Figure 127. Instrument Teach Wizard, Position Number Window](image)
**Instrument Teach Wizard - Place Microplate Window**

The Place Microplate window describes where to place the plate for teaching and prepares to release the motors for teaching.

![Figure 128. Instrument Teach Wizard, Place Microplate Window](image)

Clicking **Next** causes the robot arm to drop. Be sure to hold the robot arm before clicking Next to prevent the arm from dropping.

**Instrument Teach Wizard - Teach Location 1 Window**

The Teach Location 1 window shows how to position the robot and plate for teaching the first instrument location.

![Figure 129. Instrument Teach Wizard, Teach Location 1 Window](image)

Clicking **Next** creates position 1 on the Position tab.

**Grip buttons** - Open and close the gripper if you need to grip or release a plate.

**Servo Control buttons** - Enables or disables the robot axes.
Instrument Teach Wizard - Clearance Position Window

Use the Clearance Position window to teach the Pick Clearance and Place Clearance positions for the instrument position.

The preferred method is to click the **Move Up 1 CM** button until the bottom of the tallest material used in the instrument will clear the plate locators in the instrument. This method is more accurate because it ensures that the Clearance position is directly above the Pick/Place position.

Alternatively, you can place the tallest material used in the system into the position you just taught, and then place the material used for position teaching on top of it.

Clicking **Next** creates the clearance positions on the **Positions** tab.

![Figure 130. Instrument Teach Wizard, Clearance Position Window](image)

**Grip buttons** - Open and close the gripper if you need to grip or release a plate.

**Servo Control buttons** - Enables or disables the robot axes.
**Instrument Teach Wizard - Different Pick Position Window**

Use the Different Pick Position window to specify whether the instrument returns the material in a slightly different location that the pick position. For example, some washers and readers return the plate in slightly different position from where it was placed.

![Figure 131. Instrument Teach Wizard, Different Pick Position Window](image)

If you choose **Yes**, the Teach Pick Position window (see page 154) and Teach PickClearance Position windows display next.

If you choose **No**, the Place and PlaceClearance positions are used to create the Pick and Pick Clearance positions (respectively) and the Teach Clearance Path window opens (see page 156).

**Grip buttons** - Open and close the gripper if you need to grip or release a plate.

**Servo Control buttons** - Enables or disables the robot axes.
Instrument Teach Wizard - Teach Pick Position Window

The Teach Pick Position window opens if you select “Yes” when asked whether to teach a different Pick position.

The Teach Pick Position window shows you how to position the robot for teaching the Pick position for the current instrument position.

![Image of Teach Pick Position window]

Figure 132. Instrument Teach Wizard, Teach Pick Position window

Clicking Next creates the Pick position on the Position tab and opens the Teach PickClearance window.
Instrument Teach Wizard - Teach PickClearance Position Window

Use the Teach PickClearance Position window to teach the PickClearance position when the instrument returns the materials in a slightly different location.

The preferred method is to click the Move Up 1 CM button until the bottom of the tallest material used in the instrument will clear the plate locators in the instrument. This method is more accurate because it ensures that the PickClearance position is directly above the Pick position.

Alternatively, you can place the tallest material used in the system into the position you just taught, and then place the material used for position teaching on top of it.

Clicking Next creates the PickClearance position on the Positions tab.

Figure 133. Instrument Teach Wizard, Teach PickClearance Position Window
Instrument Teach Wizard - Teach Clearance Path Window

The Teach Clearance Path window enables you to teach a path out of the instrument if the robot does not have a clear path straight up to vertical home.

If the robot is clear to move straight up out of the instrument, click the Next button.

![Option Definition](image)

<table>
<thead>
<tr>
<th>Option</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disable</td>
<td>Disables the motors for teaching and enables you to move the robot to the next clearance path position.</td>
</tr>
<tr>
<td>Teach</td>
<td>Teaches the current position of the robot and adds it as a position in the Clearance and Approach paths.</td>
</tr>
</tbody>
</table>

If there are multiple locations to teach and you are not teaching the last location, the Position Number window (see page 150) opens to teach the next location. (Note that the Location number is displayed on the window.)
Instrument Teach Wizard - Finish Window

If there are no additional material locations for this instrument, the Finish window opens.

![Figure 135. Instrument Teach Wizard, Finish Window](image)

Clicking **Finish** closes the Instrument Teach Wizard. The Save Changes window prompts you to save your changes.

- If you choose **Yes**, the changes are saved, the teach wizard closes, and the new positions are displayed in the Robot software.

- If you choose **No**, the changes are displayed in the software but are not saved. To keep the changes, select File→Save or File→Save As on the Robot main window. To discard the changes, close the Robot software and choose No When prompted to save the changes.

![Figure 136. Save Changes Window](image)
Stack Storage Software

For systems that include the Twister II robot, the Twister II storage racks, and the CLARA software, the Stack Storage software is used to control material placement in the Twister II racks. This section describes the windows in the Stack Storage software.

Stack Storage Main Window

The Stack Storage software main window (see Figure 137) contains the following parts:

Menu Bar

The Menu bar contains the following menus:

Configuration Menu

**New** - Opens the Choose CLARA Application window (see page 161). If CLARA is installed on a different PC from the Stack Storage software, a Browse window opens (see page 160).

**Open** - Opens the Open Configuration window (see page 165) to display all CLARA applications previously created in the Stack Storage software.

**Delete** - Opens the Delete Configuration window (see page 167) to delete a configuration.
View Menu

Runtime - Opens the Runtime Stack Storage Configuration window (see page 168) to view the current location of materials in the racks while a CLARA application is running or to recover from an error. Only available while a CLARA application is running.

Help Menu

About - Opens the About Stack Storage window (see page 170).

Tool Bar

The Tool bar contains the following buttons:

New Button - Opens the Choose CLARA Application window (see page 161). If CLARA is installed on a different PC than the Stack Storage software, a Browse window opens (see page 160).

Open Button - Opens the Open Configuration window (see page 165) to display all CLARA applications previously created in the Stack Storage software.

View Button - Opens the Runtime Stack Storage Configuration window (see page 168) to view the current location of materials in the racks while a CLARA application is running or to recover from an error. Only available while a CLARA application is running.

Delete Button - Opens the Delete Configuration window (see page 167) to delete a configuration.

Advanced Button - Not currently used.

Help Button - Opens the About Stack Storage window, (see page 170).
Network Browse Window

If CLARA is on a different computer than the Stack Storage software, the Network Browse window opens as shown in Figure 138.

![Browse for Computer Window](image)

**Figure 138. Browse for Computer Window**

Use this window to locate the computer where CLARA is installed. Once you have selected the CLARA computer, this window does not display again.

Analyze Application Window

The **Analyze Application** window (see Figure 139) displays the progress of the analysis of the CLARA application. As the bar progresses across the window, the Stack Storage software gathers data from the selected CLARA application.

![Analyzing CLARA application](image)

**Figure 139. Analyze Application Window**

When the analysis is complete, the material configuration is displayed in the **Capacity Planning** window (see page 162).
Choose CLARA Application Window

The **Choose CLARA Application** window (see Figure 140) displays the applications open in the CLARA Execution Manager software.

![Choose CLARA Application Window](image)

**Figure 140. Choose CLARA Application Window**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application list</td>
<td>Displays all available CLARA applications.</td>
</tr>
<tr>
<td>Material Group</td>
<td>Choose whether to sort material by the CLARA Material Name or by the CLARA Material Type.</td>
</tr>
<tr>
<td></td>
<td>• Choose <strong>Name</strong> to stack materials by the material name. The Stack Storage software groups all the materials of one name together, adding an empty “output” rack between each material group. Material types are not considered in the grouping.</td>
</tr>
<tr>
<td></td>
<td>• Choose <strong>Type</strong> to stack materials by the material type. The Stack Storage software groups all the materials of one type together, adding an empty “output” rack between each material type. Material names are not considered in the grouping.</td>
</tr>
<tr>
<td>OK</td>
<td>Starts the CLARA application analysis and opens the <strong>Analyze Application</strong> window (see page 160) to determine the materials used in the application.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Closes the window without creating a material configuration.</td>
</tr>
</tbody>
</table>
Capacity Planning Window

The **Capacity Planning** window (see Figure 141) displays the data gathered from the selected CLARA application.

![Figure 141. Capacity Planning Window](image)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Racks**            | The number of racks in the system. Click in the **Racks** column to edit the number of racks. Enter the exact number of racks in the system so the configuration process can verify the capacity. Options:  
  • 1 - 3  
  • 1 - 6  
  • 1 - 9  
  • 1 - 12 |
| **Instrument Name**  | The Twister II storage instrument’s resource name in CLARA. Non-editable.                                                                                                                                 |
| **Maximum Capacity** | A user-defined number that represents the maximum capacity of one rack, for the Material Type listed. Click in the **Maximum Capacity** column to edit the value. **You must edit or verify the default value that is provided.** (For information on determining the maximum capacity of a rack, see “Setting up a Storage Configuration” on page 29.)  
  **Lids:** When using plates with lids, count the number of plates plus the number of lids. The total stack of materials MUST be below the top of the rack.  
  **For Example:** **Material A, Material A with lids.** The lid must be the same material type as the material. |
The Edit buttons (see Figure 142) are used to accept or reject changes to the material and storage rack data.

### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tip Box Base Height</td>
<td>If the Material is a Tip Box, specify the height of the tip box base in millimeters. (Only racked tips can be used in the racks.) This prevents the robot from trying to retrieve more tips once all of the tip racks have been removed from the tip box base. (For information on determining the base height measurement, see “Setting up a Storage Configuration” on page 29.)</td>
</tr>
<tr>
<td>Material Type Material Name</td>
<td>Type of material as defined in the CLARA application. Non-editable field. The material name as defined in the CLARA application. Non-editable field.</td>
</tr>
<tr>
<td>OK</td>
<td>Accepts changes made to the material configuration and opens the New Stack Storage Configuration Window on page 164.</td>
</tr>
</tbody>
</table>

#### Edit Buttons

The **Edit** buttons (see Figure 142) are used to accept or reject changes to the material and storage rack data.

<table>
<thead>
<tr>
<th>Option</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Close</td>
<td><img src="100" alt="X" /></td>
<td>Closes the row for editing without saving changes to the data.</td>
</tr>
<tr>
<td>Close and Save</td>
<td><img src="100" alt="✓" /></td>
<td>Closes the row for editing and saves changes to the data.</td>
</tr>
<tr>
<td>Dock/Undock</td>
<td><img src="100" alt="Dock/Undock" /></td>
<td>Use this button to drag the Edit buttons away from the Capacity window, and dock the Edit buttons on the Capacity window.</td>
</tr>
</tbody>
</table>

**Figure 142. Edit Buttons**
New Stack Storage Configuration Window

The New Stack Storage Configuration window (see Figure 143) displays the racks where the materials must be located to run the CLARA application. The New Stack Storage Configuration window opens when you click the OK button on the Capacity Planning window (see page 162). This window is for viewing only; You cannot change any of the settings on this window.

![New Stack Storage Configuration Window](image)

**Figure 143. New Stack Storage Configuration Window**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Racks Display</td>
<td>Graphical representation of the Twister II racks.</td>
</tr>
<tr>
<td>Rack</td>
<td>The rack number that the data in the row applies to.</td>
</tr>
<tr>
<td>Material Name</td>
<td>The name of the material, as defined in the CLARA application, that must be placed in the specified rack.</td>
</tr>
<tr>
<td>Quantity</td>
<td>The number of materials that must be loaded into the rack. The quantity of materials should match the number of runs in the CLARA chain, not the number of runs scheduled.</td>
</tr>
</tbody>
</table>
Open Configuration Window

The Open Configuration window (see Figure 144) displays all CLARA applications that have had material configurations created.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source/Destination</td>
<td>The type of rack: Source or Destination.</td>
</tr>
<tr>
<td></td>
<td>• Source - A rack that the robot is taking materials from.</td>
</tr>
<tr>
<td></td>
<td>• Destination - A rack that the robot is moving materials to.</td>
</tr>
<tr>
<td></td>
<td>The rack type is determined by the CLARA application.</td>
</tr>
<tr>
<td>Tip Base Height</td>
<td>The height of the tip box base in millimeters, as specified in the Capacity Planning window.</td>
</tr>
<tr>
<td>OK</td>
<td>Closes and saves the configuration.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Closes the New Stack Storage Configuration window without saving the configuration.</td>
</tr>
</tbody>
</table>

Configuration List - Displays all of the material configurations that have been created for CLARA applications.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OK</td>
<td>Opens the selected material configuration. The configuration displays in the Stack Storage Configuration window (see page 166).</td>
</tr>
<tr>
<td>Cancel</td>
<td>Closes the Open Configuration window without opening a material configuration.</td>
</tr>
</tbody>
</table>
Stack Storage Configuration Window

The Stack Storage Configuration window (see Figure 145) displays the material configuration for the CLARA application you selected in the Open Configuration Window (see page 165). The Stack Storage Configuration window opens when you click the OK button on the Open Configuration window. This window is for viewing only; You cannot change any of the settings on this window.

![Figure 145. Stack Storage Configuration Window](image)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Racks</td>
<td>Graphical view of the materials in the racks.</td>
</tr>
<tr>
<td>Rack</td>
<td>The rack number that the data in the row applies to.</td>
</tr>
<tr>
<td>Material Name</td>
<td>The name of the material, as defined in the CLARA application that must be placed in the specified rack.</td>
</tr>
<tr>
<td>Quantity</td>
<td>The number of materials that must be loaded into the rack. The quantity of materials should match the number of runs in the CLARA chain, not the number of runs scheduled.</td>
</tr>
</tbody>
</table>
The **Delete Configuration** window (see Figure 146) enables you to delete the material configuration for a CLARA application.

### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Source/Destination</strong></td>
<td>The type of rack: Source or Destination.</td>
</tr>
<tr>
<td></td>
<td>• Source - A rack that the robot is taking materials from.</td>
</tr>
<tr>
<td></td>
<td>• Destination - A rack that the robot is moving materials to.</td>
</tr>
<tr>
<td></td>
<td>The rack type is determined by the CLARA application.</td>
</tr>
<tr>
<td><strong>Tip Base Height</strong></td>
<td>The height of the tip box base in millimeters, as specified in the Capacity Planning window.</td>
</tr>
<tr>
<td><strong>OK</strong></td>
<td>Closes the Stack Storage Configuration window.</td>
</tr>
<tr>
<td><strong>Cancel</strong></td>
<td>Closes the Stack Storage Configuration window.</td>
</tr>
</tbody>
</table>

### Delete Configuration Window

The **Delete Configuration** window enables you to delete the material configuration for a CLARA application.

![Figure 146. Delete Configuration Window](image)

### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>OK</strong></td>
<td>Deletes the configuration selected in the Application list. Clicking <strong>OK</strong> opens the following window:</td>
</tr>
</tbody>
</table>

![Figure 147. Delete Warning Window](image)
The **Runtime Stack Storage Configuration** window (see Figure 148):

- displays the positions of the materials in the racks while a CLARA application is running, and
- enables you to re-position materials during CLARA error recovery.

To open the Runtime Stack Storage Configuration window, on the Stack Storage main window, select **View** → **Runtime** while a CLARA application is running.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cancel</td>
<td>Closes the <strong>Delete Configuration</strong> window without deleting a configuration.</td>
</tr>
</tbody>
</table>

**Runtime Stack Storage Configuration Window**

**Figure 148. Runtime Stack Storage Configuration Window**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Racks</td>
<td>Graphical view of the materials in the racks. The material locations are updated as the materials are moved by the robot.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>+/-</td>
<td>Buttons to add or remove a material from the rack above the buttons. Click “+” to add one material to the rack or click “-” to remove one material from the rack. (Only for use during error recovery.)</td>
</tr>
<tr>
<td>S/D</td>
<td>Buttons to define a rack as a Source or Destination rack. Changes the Source/Destination field, as appropriate. (Only for use during error recovery.)</td>
</tr>
<tr>
<td>Rack</td>
<td>The rack number that the data in the row applies to.</td>
</tr>
<tr>
<td>Material Name</td>
<td>The name of the material that is in the rack, as defined in the CLARA application.</td>
</tr>
<tr>
<td>Quantity</td>
<td>The number of materials that are in the rack.</td>
</tr>
<tr>
<td>Source/Destination</td>
<td>The type of rack: Source or Destination.</td>
</tr>
<tr>
<td></td>
<td>• Source - A rack that the robot is taking materials from.</td>
</tr>
<tr>
<td></td>
<td>• Destination - A rack that the robot is moving materials to.</td>
</tr>
<tr>
<td></td>
<td>This setting is determined by the CLARA application.</td>
</tr>
<tr>
<td>Tip Base Height</td>
<td>The height of the tip box base in millimeters, as specified in the Capacity Planning window.</td>
</tr>
<tr>
<td>OK</td>
<td>Saves any changes made to the material positions. If you make changes during a CLARA run, the following error window opens.</td>
</tr>
</tbody>
</table>

Click Yes to save changes. Note that making changes to the material positions during a run can cause the robot to crash, which may spill plates or damage the robot.

Click No to display the changes on the window without saving them. The window will update with the actual material positions the next time a plate is moved in the racks.

Cancel Closes the Runtime Stack Storage Configuration window.
About Stack Storage Window

The **About Stack Storage** window (see **Figure 149**) displays the software version and a System Info button to view system information.

![Figure 149. About Stack Storage Window]

Figure 149. About Stack Storage Window
Appendix B: Twister II Specifications

This section contains the Twister II and Assay Engine Twister II specifications.

General Instrument Specifications

<table>
<thead>
<tr>
<th>Plate Capacity</th>
<th>Up to 39 microplates (without lids) per rack</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Materials Supported</strong></td>
<td>• 96-well and 384-well plates made by Corning, Nunc, Falcon, or Greiner</td>
</tr>
<tr>
<td></td>
<td>• 96-deepwell plates made by Corning, Beckman, or Greiner</td>
</tr>
<tr>
<td></td>
<td>• 96-well filter plates made by Millipore or Packard</td>
</tr>
<tr>
<td></td>
<td>• 1536-well plates made by Corning or Nunc</td>
</tr>
<tr>
<td></td>
<td>• Caliper Automation Certified Pipet Tips: 200uL, 100uL, or 25uL</td>
</tr>
<tr>
<td><strong>Handling Format</strong></td>
<td>Places plates in portrait or landscape position</td>
</tr>
<tr>
<td><strong>Plate Storage</strong></td>
<td>Twister II: Maximum 3 pods with 3 racks per pod</td>
</tr>
<tr>
<td></td>
<td>Assay Engine Twister II: Maximum 3 racks</td>
</tr>
<tr>
<td><strong>PC Interface</strong></td>
<td>RS-232 serial</td>
</tr>
</tbody>
</table>

Robotic Arm

<table>
<thead>
<tr>
<th><strong>Rotary Travel</strong></th>
<th>340°</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Horizontal Reach</strong></td>
<td>8.5&quot; (21.6 cm.) span, 11.25&quot; (28.5 cm.) from the robot to 19.75&quot; (50.1 cm.) away from the robot</td>
</tr>
<tr>
<td><strong>Vertical Travel</strong></td>
<td>21.5&quot; (54.6 cm.) span, from 6.5&quot; (16.5 cm.) to 28&quot; (71.1 cm.) above the table</td>
</tr>
<tr>
<td><strong>Wrist Travel</strong></td>
<td>±135° (270° total)</td>
</tr>
</tbody>
</table>

Physical Performance

| **Rotary** | Servo Motor |
| **Vertical** | Servo Motor |
| **Home Position** | Optical sensors for rotary and vertical arm home positions |
### Physical

<table>
<thead>
<tr>
<th>Twister II Size</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Height</strong></td>
</tr>
<tr>
<td>38 inches (97 cm.)</td>
</tr>
<tr>
<td><strong>Width</strong></td>
</tr>
<tr>
<td>26 inches (66 cm.)</td>
</tr>
<tr>
<td><strong>Depth</strong></td>
</tr>
<tr>
<td>26 inches (66 cm.)</td>
</tr>
<tr>
<td><strong>Weight</strong></td>
</tr>
<tr>
<td>55 lbs. (25 kg.)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Assay Engine Twister II:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Size</strong></td>
</tr>
<tr>
<td>21 in (53.3 cm.) wide</td>
</tr>
<tr>
<td>28 in (77 cm.) deep</td>
</tr>
<tr>
<td>38 in (97 cm.) high</td>
</tr>
<tr>
<td><strong>Weight</strong></td>
</tr>
<tr>
<td>70 lbs. (31.8 kg.)</td>
</tr>
</tbody>
</table>

### Electrical

<table>
<thead>
<tr>
<th>Electrical Voltage</th>
</tr>
</thead>
<tbody>
<tr>
<td>100-240V ~, autosensing</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Line Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>50/60 Hz</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Twister II Fuses</th>
</tr>
</thead>
<tbody>
<tr>
<td>100/120V operation: 1 x F3.0A250V, 0.25 x 1.25” (P/N 36483)</td>
</tr>
<tr>
<td>240V operation: 2 x T1.6A250V, 5 x 20mm, (P/N 44232)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Assay Engine Twister II Fuses</th>
</tr>
</thead>
<tbody>
<tr>
<td>100 - 240V operation: 2 x T2.5A250V, 5 x 20mm (P/N 114703)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Grounding</th>
</tr>
</thead>
<tbody>
<tr>
<td>Equipment is Class 1 and shall be connected to an outlet that has proper grounding to ensure safety.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Maximum Power Input</th>
</tr>
</thead>
<tbody>
<tr>
<td>150 VA</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Input Current</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.5A</td>
</tr>
</tbody>
</table>
## Environmental

<table>
<thead>
<tr>
<th>Specification</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating Temperature</td>
<td>39.2° to 86°F (4° to 30°C)</td>
</tr>
<tr>
<td>Operating Humidity</td>
<td>0% to 85% relative humidity, non-condensing</td>
</tr>
<tr>
<td>Storage Temperature</td>
<td>-4° to 149°F (-20° to 65°C)</td>
</tr>
<tr>
<td>Storage Humidity Range</td>
<td>0 to 85% relative humidity, non-condensing</td>
</tr>
<tr>
<td>Transient Overvoltages</td>
<td>Installation Category II</td>
</tr>
<tr>
<td>Pollution</td>
<td>Pollution Degree 2</td>
</tr>
<tr>
<td>Altitude</td>
<td>Up to 2000M</td>
</tr>
<tr>
<td>Indoor Use Only</td>
<td></td>
</tr>
</tbody>
</table>
Index

A
Abort Move button ........................................ 122
Abort operation error recovery .......................... 49
Aborted status ................................................. 120
About Stack Storage window ............................. 170
About Twister II Robot ICP window ..................... 139
Absolute Position ............................................. 19
teaching for XP robot ...................................... 84
Add Position window ......................................... 133
Alarms, recovering ............................................ 45
Analyze Application window ............................... 160
Approach path .................................................. 18, 19
using .......................................................... 55
Arm
  reach ......................................................... 90
  specifications ............................................. 171
  vertical .................................................... 90
Axis definitions ............................................... 90

B
Busy status ..................................................... 120

C
Caliper Center for Training and Development .............. 8
Canister ......................................................... 92
Capacity Planning window .................................. 162
Changing fuses ............................................... 105, 108
Choose CLARA Application window ...................... 161
Choosing CLARA application ............................ 31
CLARA
  analyze application ....................................... 160
  capacity planning ........................................ 162
  preparing to run ......................................... 43
  recovering from alarms .................................. 45
  running robot ............................................ 42
Cleaning
  rack base ................................................... 105
  Twister II .................................................. 104
Clear path ..................................................... 18, 19
using .......................................................... 55
Clearance position .......................................... 17, 18
Clearance Position window ................................ 152
Comm port
  location ...................................................... 98, 100
  setting ....................................................... 26
  Settings window ......................................... 136
  Communication error .................................... 28
  Communications cable disconnecting ................. 109
  hardware description .................................... 103
  Configuration
    storage ................................................... 21
    window .................................................... 164
  Configuring racks ........................................ 29
  Continue Operation error recovery ..................... 48
  Crash, troubleshooting ................................... 111
  Customer Support plans .................................. 8
  Customizing Robot software .............................. 28

D
Defining number of racks .................................. 33
Delete Configuration window ................................ 167
Destination rack ............................................. 29
Device positions
  adjusting .................................................... 114
  re-teaching ............................................... 113
  teaching ................................................... 64
Different Pick Position window ............................ 153

E
Editing material and rack data ............................ 163
Electrical specifications .................................. 172
Environmental Specifications ............................. 173
Environmental specifications ................................ 173
Error
  communication ............................................. 28
  Recovery .................................................... 45
  recovery during Move Instruction ..................... 45
  recovery during restack .................................. 47
  status ....................................................... 120
Error recovery
  Abort operation ........................................... 49
  Continue .................................................... 48
  Retry ......................................................... 48

F
Find Material ................................................. 148
Finish window
  Instrument Teach wizard ................................. 157
  Rack Teach wizard ....................................... 146
<table>
<thead>
<tr>
<th>Index</th>
<th>175</th>
</tr>
</thead>
<tbody>
<tr>
<td>Firmware version</td>
<td>129</td>
</tr>
<tr>
<td>Fuse</td>
<td></td>
</tr>
<tr>
<td>block</td>
<td>106, 109</td>
</tr>
<tr>
<td>changing</td>
<td>105, 108</td>
</tr>
<tr>
<td>location</td>
<td>98, 100</td>
</tr>
<tr>
<td>specifications</td>
<td>172</td>
</tr>
<tr>
<td><strong>G</strong></td>
<td></td>
</tr>
<tr>
<td>General instrument specifications</td>
<td>171</td>
</tr>
<tr>
<td>Grip</td>
<td></td>
</tr>
<tr>
<td>axis</td>
<td>91</td>
</tr>
<tr>
<td>cleaning</td>
<td>104</td>
</tr>
<tr>
<td>Home position</td>
<td>122</td>
</tr>
<tr>
<td>Group by Name or Type</td>
<td>21</td>
</tr>
<tr>
<td><strong>H</strong></td>
<td></td>
</tr>
<tr>
<td>Handles on rack</td>
<td>102</td>
</tr>
<tr>
<td>Hardware overview</td>
<td>89</td>
</tr>
<tr>
<td>Home</td>
<td>27</td>
</tr>
<tr>
<td>Grip</td>
<td>122</td>
</tr>
<tr>
<td>Reach</td>
<td>121</td>
</tr>
<tr>
<td>Rotary</td>
<td>121</td>
</tr>
<tr>
<td>Track</td>
<td>122</td>
</tr>
<tr>
<td>Vertical</td>
<td>121</td>
</tr>
<tr>
<td>Wrist</td>
<td>122</td>
</tr>
<tr>
<td>Homing the robot</td>
<td>27, 52</td>
</tr>
<tr>
<td><strong>I</strong></td>
<td></td>
</tr>
<tr>
<td>Idle status</td>
<td>120</td>
</tr>
<tr>
<td>iLink PRO materials</td>
<td>35</td>
</tr>
<tr>
<td>iLink PRO Storage software</td>
<td>35</td>
</tr>
<tr>
<td>INI file</td>
<td></td>
</tr>
<tr>
<td>creating new</td>
<td>25</td>
</tr>
<tr>
<td>opening in Standalone</td>
<td>51</td>
</tr>
<tr>
<td>robot</td>
<td>20</td>
</tr>
<tr>
<td>Initializing</td>
<td></td>
</tr>
<tr>
<td>robot for setup</td>
<td>27</td>
</tr>
<tr>
<td>robot in Standalone mode</td>
<td>52</td>
</tr>
<tr>
<td>troubleshooting the robot</td>
<td>111</td>
</tr>
<tr>
<td>Instrument</td>
<td></td>
</tr>
<tr>
<td>adjusting positions</td>
<td>114</td>
</tr>
<tr>
<td>re-teaching positions</td>
<td>113</td>
</tr>
<tr>
<td>teaching multiple positions</td>
<td>77</td>
</tr>
<tr>
<td>teaching positions</td>
<td>64</td>
</tr>
<tr>
<td>Instrument position</td>
<td></td>
</tr>
<tr>
<td>moving the robot manually</td>
<td>55</td>
</tr>
<tr>
<td>Instrument Teach Wizard</td>
<td></td>
</tr>
<tr>
<td>Clearance Position window</td>
<td>152</td>
</tr>
<tr>
<td>Different Pick Position window</td>
<td>153</td>
</tr>
<tr>
<td>Finish Window</td>
<td>157</td>
</tr>
<tr>
<td>Number of Locations window</td>
<td>149</td>
</tr>
<tr>
<td>Place Microplate window</td>
<td>151</td>
</tr>
<tr>
<td>Plate Delivery Mode window</td>
<td>148</td>
</tr>
<tr>
<td>Position Number window</td>
<td>150</td>
</tr>
<tr>
<td>Set Speed window</td>
<td>148</td>
</tr>
<tr>
<td>software reference</td>
<td>147</td>
</tr>
<tr>
<td>Teach Clearance Path window</td>
<td>156</td>
</tr>
<tr>
<td>Teach Location 1 window</td>
<td>151</td>
</tr>
<tr>
<td>Teach Pick Position window</td>
<td>154</td>
</tr>
<tr>
<td>Teach PickClearance Position window</td>
<td>155</td>
</tr>
<tr>
<td>Welcome window</td>
<td>147</td>
</tr>
<tr>
<td>Introduction</td>
<td>16</td>
</tr>
<tr>
<td><strong>J</strong></td>
<td></td>
</tr>
<tr>
<td>Jog buttons</td>
<td>121</td>
</tr>
<tr>
<td><strong>L</strong></td>
<td></td>
</tr>
<tr>
<td>Lids</td>
<td>22</td>
</tr>
<tr>
<td>capacity of plates with lids</td>
<td>162</td>
</tr>
<tr>
<td>material type</td>
<td>32</td>
</tr>
<tr>
<td>setting up storage configuration</td>
<td>37</td>
</tr>
<tr>
<td>Location problems</td>
<td>111</td>
</tr>
<tr>
<td>Log window</td>
<td>135</td>
</tr>
<tr>
<td>Long-term shutdown</td>
<td>110</td>
</tr>
<tr>
<td><strong>M</strong></td>
<td></td>
</tr>
<tr>
<td>Macros</td>
<td>20</td>
</tr>
<tr>
<td>creating</td>
<td>138</td>
</tr>
<tr>
<td>Maintenance</td>
<td>104</td>
</tr>
<tr>
<td>Manual Controls tab</td>
<td>121</td>
</tr>
<tr>
<td>using</td>
<td>53</td>
</tr>
<tr>
<td>Manually teaching positions</td>
<td>83</td>
</tr>
<tr>
<td>Material</td>
<td></td>
</tr>
<tr>
<td>choosing group</td>
<td>161</td>
</tr>
<tr>
<td>Configuration</td>
<td>21</td>
</tr>
<tr>
<td>configuring lids</td>
<td>32</td>
</tr>
<tr>
<td>grouping materials</td>
<td>32</td>
</tr>
<tr>
<td>restacking</td>
<td>22</td>
</tr>
<tr>
<td>supported types</td>
<td>171</td>
</tr>
<tr>
<td>Material location problems</td>
<td>111</td>
</tr>
<tr>
<td>Material Safety Data Sheet</td>
<td>43, 104</td>
</tr>
<tr>
<td>Materials</td>
<td></td>
</tr>
<tr>
<td>setting capacity</td>
<td>33</td>
</tr>
</tbody>
</table>
Index

viewing current position . . . . . . . . 44
Max Capacity setting . . . . . . . . . . . . . 33
Move To Button . . . . . . . . . . . . . . . . 125
Move, error recovery . . . . . . . . . . . . . 45
Moving the robot manually . . . . . . . 50
Moving the Twister II . . . . . . . . . . . . 109
Multiple positions, teaching . . . . . . . 77
Multiple robots . . . . . . . . . . . . . . . . . 26

N
Name
creating robot name . . . . . . . . . 25
grouping by . . . . . . . . . . . . . . . . . 31
Names tab . . . . . . . . . . . . . . . . . . . 124
Network Browse window . . . . . . . 160
New
material configuration . . . . . . . . . 29
material layout in iLink PRO . . . . . 35
robot name . . . . . . . . . . . . . . . . . 25
New Path window . . . . . . . . . . . . . 133
New Stack Storage Configuration
creating . . . . . . . . . . . . . . . . . . . . 34
window . . . . . . . . . . . . . . . . . . . . 164
Number of Locations window . . . . . 149

O
Open Configuration window . . . . . . 165
Operating humidity . . . . . . . . . . . 173
Operating temperature . . . . . . . . . 173
Operation . . . . . . . . . . . . . . . . . . . . 23
starting system . . . . . . . . . . . . . . . 43
Optional Twister II components . . . . 98

P
Packing materials . . . . . . . . . . . . . . 109
Paths tab . . . . . . . . . . . . . . . . . . . . 126
Paths, definition . . . . . . . . . . . . . . 19
Performance specifications . . . . . . 171
Physical specifications . . . . . . . . . 172
Pick position . . . . . . . . . . . . . . . . . 17
PickClearance position . . . . . . . . . 17
Place Microplate window . . . . . . . 151
Place position . . . . . . . . . . . . . . . . 17
Place Teach Block window
  Rack Teach wizard . . . . . . . . . . . 144
PlaceClearance position . . . . . . . . 18
Plate Delivery Mode window
  Instrument Teach wizard . . . . . . . 148
  Plate Location window . . . . . . . . . 134
Pod
  exterior front view . . . . . . . . . . . 94
  exterior rear view . . . . . . . . . . . 95
  hardware . . . . . . . . . . . . . . . . . 93
  interior view . . . . . . . . . . . . . . . 97
  rack position numbers . . . . . . . . 93, 100
top view . . . . . . . . . . . . . . . . . . . 96
Pollution . . . . . . . . . . . . . . . . . . . . . 173
POS file . . . . . . . . . . . . . . . . . . . . . . 20
Position Number window . . . . . . . 150
Position Type
  Add Position window . . . . . . . . . 133
Positions
  adjusting instrument positions . . . 114
definition . . . . . . . . . . . . . . . . . . . 17
editing for XP robot . . . . . . . . . . . . . 85
  rack positions . . . . . . . . . . . . . . . 93, 100
re-teaching instrument positions . . . 113
re-teaching rack positions . . . . . . . 113
tab . . . . . . . . . . . . . . . . . . . . . . . 124
teaching instrument positions . . . . . . . 64
teaching manually . . . . . . . . . . . . . . 83
teaching rack positions . . . . . . . . . . 56
testing . . . . . . . . . . . . . . . . . . . . . 86
troubleshooting . . . . . . . . . . . . . . . 111
types . . . . . . . . . . . . . . . . . . . . . . 19
Power
  troubleshooting . . . . . . . . . . . . . 111
  Power cord . . . . . . . . . . . . . . . . . . . 103
  Power Entry Port/Fuse Assembly . . . 98, 100
  Power loss during operation . . . . . . . 116
  Power switch . . . . . . . . . . . . . . . . . 94
  Procedure file . . . . . . . . . . . . . . . . . 20
  Processes/Exceptions Log tab . . . . . 135
  Project, creating new . . . . . . . . . . . 25
R
Rack
error during Move . . . . . . . . . . . . . . 45
handles . . . . . . . . . . . . . . . . . . . . . 102
material layout multiple materials . . . . . . 38
parts and functions . . . . . . . . . . . . . . . 102
position numbers . . . . . . . . . . . . . . . 93, 100
re-teaching positions . . . . . . . . . . . . . 113
teaching positions . . . . . . . . . . . . . . . 56
Rack Teach Wizard
- Finish window ................................... 146
- Place Teach Block window ..................... 144
- Select Racks window ............................ 143
- Set Speed window ............................... 142
- Teach Rack 1 window ........................... 144
- Teach Rack 2 window ........................... 145
- Welcome window .................................. 142

Rack Teach Wizard windows .......................... 142

Racks
- defining number .................................. 33
- Reach axis ........................................ 90
- Reach Home ....................................... 121
- Recovering from errors .......................... 45
- Relative position .................................. 19
teaching for XP robot ................................ 84

Remote mode ........................................ 22
starting Robot software ............................ 42

Replacing fuses ...................................... 105, 108
Restacking materials ............................... 22
Restacking, error recovery ........................ 47
Retry Operation error recovery .................... 48

Robot
- axes ................................................. 90
canister ............................................. 92
- checking operation .............................. 115
defining multiple .................................. 26
files .................................................. 20
hardware overview .................................. 89
INI file ............................................... 20
INI file name ........................................ 25
initializing ......................................... 27, 52
maintenance ......................................... 104
moving manually ................................... 50, 53
moving to an instrument position ............... 55
paths .................................................. 19
position types ...................................... 19
positions .......................................... 17
procedures ......................................... 20
running ............................................. 42
teaching ............................................ 56
teaching positions manually ...................... 83
teaching XP robot .................................. 83
troubleshooting .................................... 111
turning on .......................................... 24

Robot software
configuring ........................................... 26
customizing ......................................... 28
error recovery ...................................... 45
main window ........................................ 117
opening INI file .................................... 51
reference ............................................ 117
setup ................................................. 23
starting ............................................. 24
starting in Remote mode .......................... 42
starting in Standalone mode ..................... 50
terminology ......................................... 17

Robot Software Programmer’s Manual .................. 137

Robot Software reference ............................. 117
Rotary axis .......................................... 91
Rotary Home ......................................... 121
Runtime Stack Storage Configuration window ........ 44, 168

S

Safe position ........................................... 18
Sciclone, teaching .................................... 77
Select Racks window ............................... 143
Set Speed window 
Instrument Teach wizard ......................... 148
Rack Teach wizard .................................. 142
Settings window ..................................... 136
Setup ................................................. 23
Shipping carton ...................................... 109
Simulation
- choosing mode .................................... 26
- mode description .................................. 136
- mode, status bar ................................... 120

Software
- reference .......................................... 117
- starting Robot software .......................... 42
- version, About Robot window ................. 139
- version, Robot status bar ....................... 120

Source rack .......................................... 29
Source/Destination
- changing .......................................... 169
- viewing ............................................ 165

Specifications
- electrical .......................................... 172
- Environmental .................................... 173
- environmental ..................................... 173

environmental ........................................ 173
general instrument .......................... 171
physical ..................................... 172
robotic arm .................................. 171
Speed ........................................ 123
Spills, cleaning up .......................... 104
Stack Storage Configuration window 166
Stack Storage software
  configuring .................................... 29
  error recovery ............................... 45
  main window ................................ 158
  reference .................................... 158
  starting ..................................... 29
  viewing material positions .................. 44
Standalone mode ............................... 22
  starting Robot software ....................... 50
Starting
  Robot software setup ......................... 24
  Robot software, Standalone mode ............ 50
  Stack Storage software ....................... 29
  the system .................................. 43
Storage
  Configuration, definition ..................... 21
  creating configuration in CLARA ............ 29
  re-teaching positions ....................... 113
  teaching positions .......................... 56
Storage Temperature ......................... 173
Support plans .................................. 8

T

Teach block, using ............................ 61
Teach Clearance Path window .................. 156
Teach Location 1 window ......................... 151
Teach Pick Position window ..................... 154
Teach PickClearance Position window ....... 155
Teach Rack 1 window ........................... 144
Teach Rack 2 window ........................... 145
Teach tab ..................................... 123
Teach Wizard
  buttons ....................................... 140
  instrument .................................... 64, 113
  rack .......................................... 56, 113
  software reference ......................... 139
  terminology ................................ 17
Teaching
  instrument positions ......................... 64
  overview .................................... 56
  rack positions ................................ 56
  re-teaching instrument positions ............ 113
  re-teaching rack positions ................... 113
  Sciclane ..................................... 77
  XP Robot ..................................... 83
  Test and Verify tab ........................... 86, 128
  Testing positions ............................ 86
  Tip Box Base Height .......................... 163, 165, 167, 169
  setting ....................................... 34
  Track Home ................................... 122
  Transient Overvoltages ....................... 173
  Troubleshooting ............................. 111
  arm position ................................ 111
  Twister II ................................... 111
  Turning on
    system .................................... 43
    troubleshooting ............................ 111
  Twister II
    cleaning .................................... 104
    hardware ................................... 89
    long term shutdown ......................... 110
    maintenance ............................... 104
    moving ..................................... 109
    performance checks ......................... 115
    specifications ............................ 171
    weight ..................................... 172
  Type, grouping by ............................ 31

U

Update Status button .......................... 129
UPS ............................................ 116

V

VBA
  editing positions manually .................... 85
  Macros window ............................... 138
  Teaching positions manually ..................... 83
  using VBA editor ............................. 20
  Vertical axis .................................. 90
  Vertical Home ................................ 121
  Viewing material positions .................... 44
  Visual Basic Editor window .................... 137

W

Weight specifications .......................... 172
Welcome window
  Instrument Teach wizard ....................... 147
Rack Teach wizard ............... 142
Wizard
   Instrument Teach ............. 64, 113
   Rack Teach .................. 56, 113
Wrist axis ..................... 91
Wrist Home .................... 122

X

XP Robot, teaching .............. 83
XPD file ....................... 20